HP ZBook 17 Mobile Workstation

Maintenance and Service Guide

IMPORTANT! This document is intended for HP authorized service providers only.
Product notice

This guide describes features that are common to most models. Some features may not be available on your computer.

Not all features are available in all editions of Windows 8. Your computer may require upgraded and/or separately purchased hardware, drivers, and/or software to take full advantage of Windows 8 functionality. See http://www.microsoft.com for details.
Important Notice about Customer Self-Repair Parts

⚠️ **CAUTION:** Your computer includes Customer Self-Repair parts and parts that should only be accessed by an authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for Authorized Service Provider only parts," can damage the computer or void your warranty.
Important Notice about Customer Self-Repair Parts
Safety warning notice

⚠️ WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of Information Technology Equipment (IEC 60950).
# Table of contents

1 Product description .......................................................................................................................................................... 1

2 External component identification .................................................................................................................................. 8
   Top .................................................................................................................................................................................. 8
      TouchPad ................................................................................................................................................................. 8
      Lights ....................................................................................................................................................................... 9
      Buttons and speakers .................................................................................................................................................. 10
      Keys ........................................................................................................................................................................ 12
   Front ........................................................................................................................................................................... 14
   Right ......................................................................................................................................................................... 15
   Left .......................................................................................................................................................................... 16
   Rear .......................................................................................................................................................................... 17
   Display ...................................................................................................................................................................... 18
   Bottom ....................................................................................................................................................................... 19
   Service tag and PCID label ......................................................................................................................................... 21
      Service tag ........................................................................................................................................................... 21
      PCID label ........................................................................................................................................................... 22
      Windows 8 models ................................................................................................................................................. 23
      Non Windows 8 models .................................................................................................................................... 23

3 Illustrated parts catalog .................................................................................................................................................. 24
   Computer major components ................................................................................................................................... 24
   Display components .................................................................................................................................................. 28
   Plastics Kit ............................................................................................................................................................... 30
   Cable Kit ................................................................................................................................................................. 31
   Bracket Kit .............................................................................................................................................................. 32
   Mass storage devices ............................................................................................................................................... 33
   Miscellaneous parts ............................................................................................................................................... 35
   Sequential part number listing ................................................................................................................................ 36
4 Removal and replacement procedures preliminary requirements ......................................... 41
  Tools required .................................................................................................................. 41
  Service considerations ................................................................................................. 41
    Plastic parts .................................................................................................................. 41
    Cables and pointing stick connectors ........................................................................ 41
    Drive handling .......................................................................................................... 42
  Grounding guidelines ..................................................................................................... 42
    Electrostatic discharge damage .............................................................................. 42
    Packaging and transporting guidelines .................................................................. 43
    Workstation guidelines ......................................................................................... 44
    Equipment guidelines ............................................................................................. 44

5 Removal and replacement procedures for Customer Self-Repair parts ............................. 46
  Component replacement procedures ............................................................................... 46
    Battery ..................................................................................................................... 46
    SIM ......................................................................................................................... 47
    Service door ............................................................................................................. 48
    Hard drives, primary and secondary ........................................................................ 49
    Solid-state drive (SSD) – mSATA ............................................................................ 51
    WLAN module ......................................................................................................... 52
    WWAN module ......................................................................................................... 54
    RTC battery .............................................................................................................. 55
    Optical drive ............................................................................................................. 57
    Upgrade bay hard drive ........................................................................................... 59
    Expansion memory module ..................................................................................... 62
    Keyboard .................................................................................................................. 63
    Primary memory module .......................................................................................... 65

6 Removal and replacement procedures for Authorized Service Provider parts .................. 67
  Component replacement procedures ............................................................................. 67
    Display bezel ............................................................................................................. 67
    Webcam module ........................................................................................................ 69
    Display panel ............................................................................................................. 70
    Top cover .................................................................................................................. 72
    Speaker assembly .................................................................................................... 75
    Multifunction board ................................................................................................. 77
    Touchpad .................................................................................................................... 79
    Fingerprint reader .................................................................................................... 80
    Power button board ................................................................................................. 82
    Display assembly ...................................................................................................... 84
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExpressCard assembly</td>
<td>91</td>
</tr>
<tr>
<td>Smart Card reader</td>
<td>92</td>
</tr>
<tr>
<td>Audio/USB board</td>
<td>93</td>
</tr>
<tr>
<td>Processor heat sink</td>
<td>95</td>
</tr>
<tr>
<td>Processor</td>
<td>98</td>
</tr>
<tr>
<td>Graphics board fan/heat sink assembly</td>
<td>100</td>
</tr>
<tr>
<td>Graphics board</td>
<td>103</td>
</tr>
<tr>
<td>Power connector cable</td>
<td>105</td>
</tr>
<tr>
<td>System board</td>
<td>106</td>
</tr>
<tr>
<td>7 Computer Setup (BIOS), MultiBoot, and System Diagnostics in Windows 8</td>
<td>110</td>
</tr>
<tr>
<td>Using Computer Setup</td>
<td>110</td>
</tr>
<tr>
<td>Starting Computer Setup</td>
<td>110</td>
</tr>
<tr>
<td>Navigating and selecting in Computer Setup</td>
<td>111</td>
</tr>
<tr>
<td>Restoring default settings in Computer Setup</td>
<td>111</td>
</tr>
<tr>
<td>Updating the BIOS</td>
<td>112</td>
</tr>
<tr>
<td>Determining the BIOS version</td>
<td>112</td>
</tr>
<tr>
<td>Downloading a BIOS update</td>
<td>113</td>
</tr>
<tr>
<td>Using MultiBoot</td>
<td>114</td>
</tr>
<tr>
<td>About the boot device order</td>
<td>114</td>
</tr>
<tr>
<td>Choosing MultiBoot preferences</td>
<td>114</td>
</tr>
<tr>
<td>Setting a new boot order in Computer Setup</td>
<td>114</td>
</tr>
<tr>
<td>Dynamically choosing a boot device using the f9 prompt</td>
<td>115</td>
</tr>
<tr>
<td>Setting a MultiBoot Express prompt</td>
<td>115</td>
</tr>
<tr>
<td>Entering MultiBoot Express preferences</td>
<td>116</td>
</tr>
<tr>
<td>Using System Diagnostics</td>
<td>116</td>
</tr>
<tr>
<td>8 Computer Setup (BIOS), MultiBoot, and UEFI in Windows 7</td>
<td>118</td>
</tr>
<tr>
<td>Using Computer Setup</td>
<td>118</td>
</tr>
<tr>
<td>Starting Computer Setup</td>
<td>118</td>
</tr>
<tr>
<td>Navigating and selecting in Computer Setup</td>
<td>119</td>
</tr>
<tr>
<td>Restoring default settings in Computer Setup</td>
<td>119</td>
</tr>
<tr>
<td>Updating the BIOS</td>
<td>120</td>
</tr>
<tr>
<td>Determining the BIOS version</td>
<td>120</td>
</tr>
<tr>
<td>Downloading a BIOS update</td>
<td>121</td>
</tr>
<tr>
<td>Using MultiBoot</td>
<td>122</td>
</tr>
<tr>
<td>About the boot device order</td>
<td>122</td>
</tr>
<tr>
<td>Choosing MultiBoot preferences</td>
<td>122</td>
</tr>
<tr>
<td>Setting a new boot order in Computer Setup</td>
<td>122</td>
</tr>
<tr>
<td>Dynamically choosing a boot device using the f9 prompt</td>
<td>123</td>
</tr>
<tr>
<td>Setting a MultiBoot Express prompt</td>
<td>123</td>
</tr>
</tbody>
</table>
Entering MultiBoot Express preferences ................................................................. 124
Using HP PC Hardware Diagnostics (UEFI) (select models only) .................................. 124
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device .............................. 124

9  Computer Setup (BIOS) and Advanced System Diagnostics in SUSE Linux 126
Starting Computer Setup ......................................................................................... 126
Using Computer Setup .............................................................................................. 127
Navigating and selecting in Computer Setup .......................................................... 127
Restoring default settings in Computer Setup ......................................................... 128
Updating the BIOS .................................................................................................... 128
Determining the BIOS version .................................................................................. 128
Downloading a BIOS update ..................................................................................... 129
Using Advanced System Diagnostics ......................................................................... 129

10 Specifications ...................................................................................................... 131
Computer specifications ............................................................................................ 131
43.9 cm (17.3 in) HD+ display specifications ............................................................. 132
43.9 cm (17.3 in) FHD display specifications ............................................................. 132
Hard drive specifications ........................................................................................... 133
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive specifications ....................... 134
Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive specifications ...................... 135
DVD±RW SuperMulti Double-Layer Drive specifications ............................................. 136
DVD-ROM Drive specifications .................................................................................. 137

11 Backup and recovery in Windows 8 ................................................................... 138
Backing up your information ..................................................................................... 138
Performing a system recovery ................................................................................... 140
Using f11 recovery tools .......................................................................................... 140
Using Windows 8 operating system media (purchased separately) ............................ 140
Using Windows Refresh for quick and easy recovery ................................................ 142
Remove everything and reinstall Windows .................................................................. 142
Using HP Software Setup ...................................................................................... 143

12 Backup and recovery in Windows 7 .................................................................... 144
Creating recovery media and backups ...................................................................... 144
Guidelines .................................................................................................................. 145
Creating recovery media with HP Recovery Disc Creator ......................................... 145
Creating recovery media .......................................................................................... 145
Backing up your information ..................................................................................... 145
Performing a system recovery ................................................................................... 146
# Product description

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Name</strong></td>
<td>HP ZBook 17 Mobile Workstation</td>
</tr>
<tr>
<td><strong>Processors</strong></td>
<td>Intel® Core™ i7 processors, (support Intel Turbo Boost Technology):</td>
</tr>
<tr>
<td></td>
<td>● i7-4930MX, 3.00 GHz (Turbo up to 3.90 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 57W</td>
</tr>
<tr>
<td></td>
<td>● i7-4900MQ, 2.80 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td></td>
<td>● i7-4800MQ, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td></td>
<td>● i7-4700MQ, 2.40 GHz (Turbo up to 3.40 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td></td>
<td>● i7-4600M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td></td>
<td>Intel Core i5 processors, (support Intel Turbo Boost Technology):</td>
</tr>
<tr>
<td></td>
<td>● i5-4330M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td></td>
<td>● i5-4300M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td><strong>Chipset</strong></td>
<td>Mobile Intel QM87</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td>Support for the following graphics subsystem boards (all feature OpenGL driver support, hybrid (switchable) graphics, DisplayPort 1.2, up to 4 total displays (through APR), and NVIDIA Mosaic Technology):</td>
</tr>
<tr>
<td></td>
<td>● NVIDIA Quadro K610M, N15E-Q2, 1 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td></td>
<td>● NVIDIA Quadro K3100M, N15E-Q1, 4 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td></td>
<td>● NVIDIA Quadro K4100M, N15E-Q3, 4 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td></td>
<td>● NVIDIA Quadro K5100M, N15E-Q5, 8 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>All displays are 16:9 aspect ratio, 7.2-mm, wedge design, LVDS panels; DreamColor requires eDP.</td>
</tr>
<tr>
<td></td>
<td>● Display assembly, 43.9 cm (17.3 in), High Definition Plus (HD+), 1600x900, Anti-Glare (AG), LED, SVA, with or without webcam</td>
</tr>
<tr>
<td></td>
<td>● Display assembly, 43.9 cm (17.3 in), Full High Definition (FHD), 1920x1080, Anti-Glare (AG), LED, WVA, with or without webcam</td>
</tr>
<tr>
<td></td>
<td>● Display assembly, 43.9 cm (17.3 in), Full High Definition (FHD), 1920x1080, Anti-Glare (AG), RGB, LED, UVWA Dream Color 2 with or without webcam (not available with HP Mobile Broadband)</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>4 customer-accessible/upgradable memory module slots</td>
</tr>
</tbody>
</table>
### Category | Description
--- | ---
Supports dual-channel memory | Supports up to 32,768 MB of system RAM
| DDR3L 1600-MHz PC3-12800 SODIMMs | Supports the following configurations:
  - 2048 MB total system memory (2048 x 1)
  - 4096 MB total system memory (2048 x 2)
  - 4096 MB total system memory (4096 x 1)
  - 8192 MB total system memory (8192 x 1)
  - 8192 MB total system memory (4096 x 2)
  - 12288 MB total system memory (8192 + 4096)
  - 16384 MB total system memory (8192 x 2)
  - 16384 MB total system memory (4096 x 4); only available on computer models equipped with a quad-core processor
  - 32768 MB total system memory (8192 x 4); only available on computer models equipped with a quad-core processor
**Flash cache** | 32 GB MLC mSATA module
| | Support for “No flash cache” option
| | Dedicated mini-card slot
| | Intel SRT (Smart Response Technology)
| | Not available with SSD or SED drives
| | Not available with Linux
| | Fast Flash Standby not supported
| | Not available if primary and secondary and Upgrade bay hard drive is selected
**Mini card SSD** | 128 GB
**Primary storage** | Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in), 6.35 cm (2.5 in) hard drives and 6.35 cm (2.5 in) solid-state drive for primary and secondary storage.
| | Supports 3D DriveGuard
| | Supports ‘tool-less’ remove mechanism
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Supports the following Serial ATA (SATA) drives:</td>
</tr>
<tr>
<td></td>
<td>● 1 TB, 5400 rpm</td>
</tr>
<tr>
<td></td>
<td>● 750 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 7200 rpm, self-encrypting drive (SED)</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 5400 rpm, self encrypting drive (SED, FIPS-140-2)</td>
</tr>
<tr>
<td></td>
<td>● 320 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):</td>
</tr>
<tr>
<td></td>
<td>● 512 GB SATA III SSD</td>
</tr>
<tr>
<td></td>
<td>● 256 GB SATA III Self Encrypting Drive (SED) SSD</td>
</tr>
<tr>
<td></td>
<td>● 180 GB SATA III SSD</td>
</tr>
<tr>
<td></td>
<td>● 128 GB SATA III SSD</td>
</tr>
<tr>
<td>Secondary</td>
<td>Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in), 6.35 cm (2.5 in) hard drives and 6.35 cm (2.5 in) solid-state drive for primary and secondary storage.</td>
</tr>
<tr>
<td>storage</td>
<td>Supports the following Serial ATA (SATA) drives:</td>
</tr>
<tr>
<td></td>
<td>● 1 TB, 5400 rpm</td>
</tr>
<tr>
<td></td>
<td>● 750 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 7200 rpm, self-encrypting drive (SED)</td>
</tr>
<tr>
<td></td>
<td>● 500 GB, 5400 rpm, self encrypting drive (SED, FIPS-140-2)</td>
</tr>
<tr>
<td></td>
<td>● 320 GB, 7200 rpm</td>
</tr>
<tr>
<td></td>
<td>Supports the following 6.35 cm (2.5 in), solid-state drives (SSD):</td>
</tr>
<tr>
<td></td>
<td>● 512 GB SATA III SSD</td>
</tr>
<tr>
<td></td>
<td>● 256 GB SATA III Self Encrypting Drive (SED) SSD</td>
</tr>
<tr>
<td></td>
<td>● 180 GB SATA III SSD</td>
</tr>
<tr>
<td></td>
<td>● 128 GB SATA III SSD</td>
</tr>
<tr>
<td>Upgrade bay</td>
<td>Support for RAID 0/1/5</td>
</tr>
<tr>
<td></td>
<td>Supports 7.0 mm (0.28 in) or 9.5 mm (0.37 in) hard drives:</td>
</tr>
<tr>
<td></td>
<td>● 750 GB, 5400 rpm</td>
</tr>
<tr>
<td></td>
<td>● 512 GB SATA III SSD</td>
</tr>
<tr>
<td></td>
<td>● 256 GB SATA III SSD, Self Encrypting Drive (SED)</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Supports 9.5 mm SATA optical drives: | • Blu-ray R/RE DVD±RW SuperMulti Double-Layer (DL) Drive  
• Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive  
• DVD±RW SuperMulti Double-Layer Drive  
• DVD-ROM Drive (defeatured combo) |
| Audio and video          | Integrated dual-array microphone  
High-definition (HD) audio with DTS Studio Sound  
2 stereo speakers  
Integrated 720p HD webcam  
Supports "No camera" option |
| Ethernet                 | Intel® I217-LM Gigabit Network Connection  
Power Optimizer Support  
Intel Stable Image Platform Program (SIPP)  
Ethernet cable not included |
| Wireless                 | Integrated wireless local area network (WLAN) options by way of the following wireless modules:  
• Intel Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module  
• Intel Centrino 6235 2x2 a/b/g/n + BT 4.0  
• Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + BT 4.0  
WLAN antennas (2) built into display assembly  
Support for "no WLAN" option |
| Wireless WWAN             | Integrated wireless wide area network (WWAN) options by way of the following wireless modules: (not available on computer models with Dream Color displays)  
• HP hs3110 HSPA+ Mobile Broadband Module  
• HP It4111 LTE/EV-DO/HSPA+ Mobile Broadband Module  
• HP It4112 LTE/HSPA+ Mobile Broadband Module  
Support for "no WWAN" option |
| Security provided by subscriber identify module (SIM) |
| External media card      | One ExpressCard slot, 54 mm  
Integrated SD UHS-II flash media slot  
Supports next generation SD (Secure Digital). Backward compatible with SDHC, SDXC. |
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ports</strong></td>
<td>Multi-pin AC port</td>
</tr>
<tr>
<td></td>
<td>Combo mic-in/Stereo headphone jack</td>
</tr>
<tr>
<td></td>
<td>DisplayPort 1.2</td>
</tr>
<tr>
<td></td>
<td>Mini DisplayPort with pass through DP 1.2 support</td>
</tr>
<tr>
<td></td>
<td>Docking connector</td>
</tr>
<tr>
<td></td>
<td>Secondary battery connector</td>
</tr>
<tr>
<td></td>
<td>RJ-45 (Ethernet, includes link and activity lights)</td>
</tr>
<tr>
<td></td>
<td>USB 3.0 (3)</td>
</tr>
<tr>
<td></td>
<td>USB 2.0 (1)</td>
</tr>
<tr>
<td></td>
<td>USB 3.0 charging port (1)</td>
</tr>
<tr>
<td></td>
<td>VGA (Dsub 15-pin) supporting 1920 × 1200 external resolution at 75 GHz (hot plug/unplug with auto-detect)</td>
</tr>
<tr>
<td><strong>Docking</strong></td>
<td>Supports the following docking stations:</td>
</tr>
<tr>
<td></td>
<td>● HP Docking Station</td>
</tr>
<tr>
<td></td>
<td>● HP Advanced Docking Station</td>
</tr>
<tr>
<td><strong>Keyboard/pointing devices</strong></td>
<td>Full sized, backlit or non-backlit, chiclet (island-style) keyboard with separate numeric keypad:</td>
</tr>
<tr>
<td></td>
<td>Spill-resistant with drain</td>
</tr>
<tr>
<td></td>
<td>Dura Keys</td>
</tr>
<tr>
<td></td>
<td>Touchpad includes DuraPad coating; glass with chemical etched surface; image sensor</td>
</tr>
<tr>
<td></td>
<td>Gestures enabled by default · 2 finger scrolling, 2 finger zoom (pinch)</td>
</tr>
<tr>
<td></td>
<td>Touchpad supports two-way scroll with legend</td>
</tr>
<tr>
<td></td>
<td>Taps enabled as default</td>
</tr>
<tr>
<td><strong>Power requirements</strong></td>
<td>Supports the following AC adapters with localized cable plug support:</td>
</tr>
<tr>
<td></td>
<td>● 200W Slim Smart AC adapter</td>
</tr>
<tr>
<td></td>
<td>● 230W Slim Smart AC adapter</td>
</tr>
<tr>
<td></td>
<td>● 3-wire plug (with ground pin)</td>
</tr>
<tr>
<td></td>
<td>Support for the following batteries:</td>
</tr>
<tr>
<td></td>
<td>● 8-cell, 2.8 Ah (83 W/Hr) Liion battery</td>
</tr>
<tr>
<td></td>
<td>● 8-cell, 2.8 Ah (75 W/Hr) Liion battery (available with 3 year warranty only)</td>
</tr>
<tr>
<td></td>
<td>● Supports 9-cell, 6.6 Ah (73 W/Hr) polymer, HP ST09 Extended Life Battery (does not support HP Fast Charge)</td>
</tr>
<tr>
<td></td>
<td>● Supports 9-cell 8.85 Ah (100 W/Hr) cylindrical battery, HP BB09 Ultra-Capacity Extended Life Battery (does not support HP Fast Charge)</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Integrated fingerprint reader</td>
</tr>
<tr>
<td></td>
<td>Integrated Smart Card reader</td>
</tr>
<tr>
<td></td>
<td>Preboot authentication (password, Smart Card)</td>
</tr>
<tr>
<td></td>
<td>Supports security lock</td>
</tr>
<tr>
<td></td>
<td>Trusted platform module (TPM) v.1.2 and TPM enhanced drive lock</td>
</tr>
</tbody>
</table>

**Operating system**

**Preinstalled operating systems:**

- Windows 8 Professional 64
- Windows 8 Professional 64 Product Key (DPK) with Windows 7 Professional 64 image (not supported in the People’s Republic of China)
- Windows 8 Emerging Markets (EM) 64
- Windows 8 Multi-language (ML) 64
- Windows 8 China (CH) 64 (only supported in the People’s Republic of China)
- Windows 7 Professional 64
- FreeDOS 2.0
- Novell™: SuSE Linux™ – SLED 11, 64-bit, SP2 (not available in models with WWAN or Blu ray drives)

**Restore media:**

**DRDVD:**

- DRDVD Windows 7
- DRDVD Windows 8
- SRDVD SuSE Linux Enterprise (SLED) SP2 64-bit

**OSDVD:**

- Windows 7 Professional 64-bit
- Windows 8 Professional 64-bit
- Windows 8 64-bit
- Windows 8 Country Specific 64-bit
- Windows 8 Emerging Market 64-bit

**Certified:**

- Microsoft WHQL
- SuSE Linux Enterprise (SLED) SP2 64-bit
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web-only support:</td>
<td>Windows 8 Enterprise 64</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Enterprise 64</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Emerging Markets 64</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Chinese Markets 64</td>
</tr>
<tr>
<td></td>
<td>Win 8.1 Professional 32</td>
</tr>
<tr>
<td></td>
<td>Win 8.1 Professional 64</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional 32</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate 64</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate 32</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise 64</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise 32</td>
</tr>
<tr>
<td></td>
<td>SuSE Linux Enterprise (SLED) SP2 64-bit</td>
</tr>
</tbody>
</table>

**Serviceability**

End-user replaceable parts:

- Memory module
- Optical drive
- Hard drive/SSD
- Battery
- AC adapter
- Keyboard
- WLAN module
- WWAN module
- mSATA
## 2 External component identification

### Top

#### TouchPad

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Pointing stick</td>
<td>Moves the pointer and selects or activates items on the screen.</td>
</tr>
<tr>
<td>(2) Left pointing stick button</td>
<td>Functions like the left button on an external mouse.</td>
</tr>
<tr>
<td>(3) Touchpad on/off button</td>
<td>Turns the Touchpad on and off.</td>
</tr>
<tr>
<td>(4) Touchpad zone</td>
<td>Moves the pointer and selects or activates items on the screen.</td>
</tr>
<tr>
<td>(5) Left TouchPad button</td>
<td>Functions like the left button on an external mouse.</td>
</tr>
<tr>
<td>(6) Right pointing stick button</td>
<td>Functions like the right button on an external mouse.</td>
</tr>
<tr>
<td>(7) Center pointing stick button</td>
<td>Functions like the center button on an external mouse.</td>
</tr>
<tr>
<td>(8) Center TouchPad button</td>
<td>Functions like the center button on an external mouse.</td>
</tr>
<tr>
<td>(9) Right TouchPad button</td>
<td>Functions like the right button on an external mouse.</td>
</tr>
</tbody>
</table>
## Lights

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Power light   | - On: The computer is on.  
                           - Blinking: The computer is in the Sleep state (Windows) or Suspend state (Linux).  
                           - Off: The computer is off. |
| (2) Caps lock light | On: Caps lock is on. |
| (3) TouchPad light | - Amber: The TouchPad is off.  
                           - Off: The TouchPad is on. |
| (4) Microphone mute light | - Amber: microphone sound is off.  
                           - Off: microphone sound is on. |
| (5) Num lock light | On: Num lock is on. |
| (6) Wireless light | - White: An integrated wireless device, such as a wireless local area network (WLAN) device and/or a Bluetooth® device, is on.  
                           - Amber: All wireless devices are off. |
| (7) Mute light    | - Amber: Computer sound is off.  
                           - Off: Computer sound is on. |
Buttons and speakers
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Power button | - When the computer is off, press the button to turn on the computer.  
- When the computer is on, press the button briefly to initiate Sleep (Windows)/Suspend (Linux).  
- When the computer is in the Sleep state, press the button briefly to exit Sleep (Windows)/Suspend (Linux).  
- When the computer is in Hibernation, press the button briefly to exit Hibernation.  
**CAUTION:** Pressing and holding down the power button will result in the loss of unsaved information.  
If the computer has stopped responding and operating system shutdown procedures are ineffective, press and hold the power button for at least 5 seconds to turn off the computer.  
To learn more about your power settings:  
**Windows 8:**  
See your power options. From the Start screen, type `power`, select `Settings`, and then select `Power Options`.  
**Windows 7:**  
See your power options. Select `Start > Control Panel > System and Settings > Power Options`.  
**Linux:**  
1. Select `Computer > Control Center`.  
2. In the left pane, click `System`, and then click `Power Management` in the right pane. |
| (2) Speakers (2) | Produce sound. |
| (3) Wireless button | Turns the wireless feature on or off but does not establish a wireless connection. |
| (4) Volume mute button | Mutes and restores speaker sound. |
| (5) Fingerprint reader | Allows a fingerprint logon to the operating system, instead of a password logon. |
### Keys

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) esc key</td>
<td>Displays system information when pressed in combination with the fn key. <strong>NOTE:</strong> Windows models only.</td>
</tr>
<tr>
<td>(2) fn key</td>
<td>Executes frequently used system functions when pressed in combination with a function key, the num lk key, the esc key, or the b key.</td>
</tr>
<tr>
<td>(3) Windows button</td>
<td><strong>Windows 8:</strong> Returns you to the Start screen from an open app or the Windows desktop. <strong>Windows 7:</strong> Displays the Windows Start menu. <strong>NOTE:</strong> Pressing the Windows button again will return you to the previous screen.</td>
</tr>
<tr>
<td>(4) Function keys</td>
<td>Execute frequently used system functions when pressed in combination with the fn key.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| (5) num lk key | **Windows 8:**  
Turns the embedded numeric keypad on and off when pressed in combination with the fn key. Alternates between the navigational and numeric functions on the integrated numeric keypad.  

**Windows 7 and Linux:**  
Alternates between the navigational and numeric functions on the integrated numeric keypad. |
| (6) Integrated numeric keypad | When num lk has been enabled, it can be used like an external numeric keypad. |
### Front

![Front panel with component descriptions](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Wireless light | - White: An integrated device, such as a wireless local area network (WLAN) device and/or a Bluetooth device, is on.  
- Amber: All wireless devices are off. |
| (2) Power light    | - On: The computer is on.  
- Blinking: The computer is in the Sleep state.  
- Off: The computer is off. |
| (3) AC adapter/Battery light | - White: The computer is connected to external power and the battery is charged from 90 to 99 percent.  
- Amber: The computer is connected to external power and the battery is charged from 0 to 90 percent.  
- Blinking amber: A battery that is the only available power source has reached a low battery level. When the battery reaches a critical battery level, the battery light begins blinking rapidly.  
- Off: The battery is fully charged. |
| (4) Hard drive light | - Blinking white: The hard drive is being accessed.  
- Amber: HP 3D DriveGuard has temporarily parked the hard drive. |
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Memory card reader</td>
<td>Reads data from and writes data to memory cards such as Secure Digital (SD).</td>
</tr>
</tbody>
</table>
| (2) Audio-out (headphone) jack/Audio-in (microphone) jack | Produces sound when connected to optional powered stereo speakers, headphones, earbuds, a headset, or television audio. Also connects an optional headset microphone.  
**WARNING!** To reduce the risk of personal injury, adjust the volume before putting on headphones, earbuds, or a headset. For additional safety information, see the Regulatory, Safety, and Environmental Notices. To access the user guides in Windows 8, select the HP Support Assistant app on the Start screen, select My computer, and then select User guides. To access the user guides in Windows 7, select the HP Support Assistant app on the Start screen, select My computer, and then select User guides.  
**NOTE:** When a device is connected to the jack, the computer speakers are disabled.  
**NOTE:** Be sure that the device cable has a 4-conductor connector that supports both audio-out (headphone) and audio-in (microphone). |
<p>| (3) USB 3.0 ports (2) | Connect optional USB 3.0 devices and provide enhanced USB power performance. |
| (4) Optical drive (select models only) | Reads and/or writes, depending on your computer model, to an optical disc. |
| (5) Optical drive eject button (select models only) | Releases the optical drive disc tray. |</p>
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Security cable slot</td>
<td>Attaches an optional security cable to the computer. <strong>NOTE:</strong> The security cable is designed to act as a deterrent, but it may not prevent the computer from being mishandled or stolen.</td>
</tr>
<tr>
<td>(2) Vent</td>
<td>Enables airflow to cool internal components. <strong>NOTE:</strong> The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation.</td>
</tr>
<tr>
<td>(3) USB 2.0 port</td>
<td>Connects an optional USB device.</td>
</tr>
<tr>
<td>(4) DisplayPort</td>
<td>Connects an optional digital display device, such as a high-performance monitor or projector.</td>
</tr>
<tr>
<td>(5) Thunderbolt port</td>
<td>Connects an optional high-resolution display device or a high-performance data device. <strong>NOTE:</strong> Windows models only. <strong>NOTE:</strong> Thunderbolt is new technology. Install all the latest drivers for your Thunderbolt device before connecting the device to the Thunderbolt port. Thunderbolt cable and Thunderbolt device (sold separately) must be compatible with Windows. To determine whether your device is Thunderbolt Certified for Windows, see <a href="https://thunderbolttechnology.net/products">https://thunderbolttechnology.net/products</a>.</td>
</tr>
<tr>
<td>(6) USB 3.0 charging port</td>
<td>Connects optional USB 3.0 devices and provides enhanced USB power performance. The USB charging port can also charge select models of cell phones and MP3 players, even when the computer is off.</td>
</tr>
<tr>
<td>(7) Smart card</td>
<td>Support optional smart cards.</td>
</tr>
<tr>
<td>(8) ExpressCard slot or smart card reader (depending on the configuration)</td>
<td>Supports optional ExpressCards or smart cards.</td>
</tr>
</tbody>
</table>
### Rear

**Component** | **Description**
--- | ---
(1) RJ-45 (network) jack | Connects a network cable.

(2) Vents (2) | Enable airflow to cool internal components.

**NOTE:** The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation.

(3) Power connector | Connects an AC adapter.

(4) AC adapter | - White: The computer is connected to external power.
- Off: The computer is not connected to external power.
## Display

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) WLAN antennas (2)* (select models only)</td>
<td>Send and receive wireless signals to communicate with wireless local area networks (WLAN).</td>
</tr>
<tr>
<td>(2) WWAN antennas (2)* (select Windows models only)</td>
<td>Send and receive wireless signals to communicate with wireless wide area networks (WWAN).</td>
</tr>
<tr>
<td>(3) Internal microphones (2)</td>
<td>Record sound.</td>
</tr>
<tr>
<td>(4) Webcam light (select models only)</td>
<td>On: The webcam is in use. Records video and captures still photographs.</td>
</tr>
<tr>
<td>(5) Webcam (select models only)</td>
<td>For information on using the webcam in Windows 8, access HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support Assistant app. For information on using the webcam in Windows 7, select Start &gt; All Programs &gt; Communication and Chat &gt; HP Webcam.</td>
</tr>
<tr>
<td>(6) Internal display switch</td>
<td>Turns off the display or initiates Sleep (Windows)/Suspend (Linux) if the display is closed while the power is on. <strong>NOTE:</strong> The display switch is not visible on the outside of the computer.</td>
</tr>
</tbody>
</table>

*The antennas are not visible on the outside of the computer. For optimal transmission, keep the areas immediately around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and Environmental Notices that applies to your country or region. To access the user guides, select the HP Support Assistant app on the Start screen, select My computer, and then select User guides.
## Bottom

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Battery release latch</td>
<td>Releases the battery.</td>
</tr>
<tr>
<td>(2) Battery bay</td>
<td>Holds the battery.</td>
</tr>
<tr>
<td>(3) SIM slot</td>
<td>Supports a wireless subscriber identity module (SIM). The SIM slot is located inside the battery bay.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Select Windows models only.</td>
</tr>
<tr>
<td>(4) Docking connector</td>
<td>Connects an optional docking device.</td>
</tr>
<tr>
<td>(5) Accessory battery connector</td>
<td>Connects an optional accessory battery.</td>
</tr>
<tr>
<td>(6) Service door release lock</td>
<td>Locks service door.</td>
</tr>
<tr>
<td>(7) Service door release latch</td>
<td>Releases the service door on the computer.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| (8) Vents (3) | Enable airflow to cool internal components.  
**NOTE:** The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation. |
| (9) Service door | Provides access to the hard drive bay, the wireless LAN (WLAN) module slot, the WWAN module slot, and the memory module slots.  
**CAUTION:** To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore computer functionality, and then contact support through HP Support Assistant. To access HP Support Assistant in Windows 8, on the Start screen, select the **HP Support Assistant** app. To access Help and Support in Windows 7, select **Start > Help and Support**. |
**Service tag and PCID label**

**Service tag**

**IMPORTANT:** All labels described in this section will be located in one of 3 places depending on your computer model: Affixed to the bottom of the computer, located in the battery bay, or under the service door.

When ordering parts or requesting information, provide the computer serial number and model number provided on the service tag.

**NOTE:** Your service labels will resemble one of the examples shown below. Refer to the illustration that most closely matches the service label on your computer.

---

<table>
<thead>
<tr>
<th>Item</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Product name</td>
<td>This is the product name affixed to the front of the computer.</td>
</tr>
<tr>
<td>(2)</td>
<td>Serial number (s/n)</td>
<td>This is an alphanumeric identifier that is unique to each product.</td>
</tr>
<tr>
<td>Item</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(3)</td>
<td>Product number (p/n)</td>
<td>This number provides specific information about the product's hardware components. The part number helps a service technician determine what components and parts are needed.</td>
</tr>
<tr>
<td>(4)</td>
<td>Warranty period</td>
<td>This number describes the duration of the warranty period for the computer.</td>
</tr>
<tr>
<td>(5)</td>
<td>Model number (select models only)</td>
<td>This is the alphanumeric identifier needed to locate documents, drivers, and support for the computer.</td>
</tr>
</tbody>
</table>

**PCID label**

The PCID label provides the information required to properly reset the notebook firmware (BIOS) back to factory shipped specifications when replacing the system board. The label may have a different number of characters depending on the operating system on the computer.

**NOTE:** Computer details may vary from images.
Windows 8 models

Non Windows 8 models
3 Illustrated parts catalog

Computer major components
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Display</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display assembly, <strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models with a webcam</td>
<td>735369-001</td>
</tr>
<tr>
<td></td>
<td>Display assembly, <strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models without a webcam</td>
<td>735368-001</td>
</tr>
</tbody>
</table>

**NOTE:** See Display components on page 28 for more display component information and spare part numbers.

| (2)  | Keyboard (backlit, includes keyboard cable, pointing stick and pointing stick cable): | 733688-xx1 |
|      | **NOTE:** For a detailed list of available keyboards, see Sequential part number listing on page 36. |

| (3)  | Top cover | 735587-001 |
| (4)  | Power button board (includes cable) | 733636-001 |
| (5)  | Memory modules (PC3L-12800, 1600 MHz, DDR3) | |
|      | 8 GB      | 693374-001 |
|      | 4 GB      | 691740-001 |

| (6)  | Fingerprint reader (includes cable) | 737730-001 |

| (7)  | Processor (includes replacement thermal material): |
|      | **Intel Core processors** (support Intel Turbo Boost Technology): |
|      | i7-4930MX, 3.00 GHz (Turbo up to 3.90 GHz), 1600 MHz, 8 MB L3 cache, 57W | 735099-002 |
|      | i7-4900MQ, 2.80 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 cache, 47W | 723523-002 |
|      | i7-4800MQ, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 6 MB L3 cache, 47W | 723524-002 |
|      | i7-4700MQ, 2.40 GHz (Turbo up to 3.40 GHz), 1600 MHz, 6 MB L3 cache, 47W | 723521-002 |
|      | i7-4600M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 cache, 37W | 737330-002 |
|      | **Intel Core i5 processors** (support Intel Turbo Boost Technology): |
|      | i5-4330M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 cache, 37W | 738201-002 |
|      | i5-4300M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 cache, 37W | 738309-002 |

| (8)  | Graphics board (includes replacement thermal material): |
|      | NVIDIA Quadro K5100M, 8 GB dedicated GDDR5 video memory | 728555-001 |
|      | NVIDIA Quadro K4100M, 4 GB dedicated GDDR5 video memory | 728556-001 |
|      | NVIDIA Quadro K3100M, 4 GB dedicated GDDR5 video memory | 728557-001 |
|      | NVIDIA Quadro K610M, 1 GB dedicated GDDR5 video memory | 728554-001 |

| (9)  | Multifunction board (includes LED light pipe) | 733639-001 |

<p>| (10) | System board (includes replacement thermal material): |
|      | For use in non-Windows 8 models | 735592-001 |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>For use in models with Windows 8 Standard</td>
<td>735592-501</td>
<td></td>
</tr>
<tr>
<td>For use in models with Windows 8 Professional</td>
<td>735592-601</td>
<td></td>
</tr>
<tr>
<td>(11) <strong>Solid-state drive</strong> (includes bracket and screws)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSD:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- 256 GB Self-Encrypting drive (SED)</td>
<td>737346-001</td>
<td></td>
</tr>
<tr>
<td>- 180 GB</td>
<td>737345-001</td>
<td></td>
</tr>
<tr>
<td>- 128 GB</td>
<td>737344-001</td>
<td></td>
</tr>
<tr>
<td>mSATA:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- 128 GB</td>
<td>737343-001</td>
<td></td>
</tr>
<tr>
<td>- 32 GB</td>
<td>737342-001</td>
<td></td>
</tr>
<tr>
<td>(12) <strong>WWAN module:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module</td>
<td>704030-001</td>
<td></td>
</tr>
<tr>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
<td>704031-001</td>
<td></td>
</tr>
<tr>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
<td>723895-001</td>
<td></td>
</tr>
<tr>
<td>(13) <strong>WLAN module</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intel Centrino Advanced-N 6205, 802.11a/b/g/n WLAN module</td>
<td>695915-001</td>
<td></td>
</tr>
<tr>
<td>Intel Centrino Advanced-N 6235</td>
<td>670292-001</td>
<td></td>
</tr>
<tr>
<td>Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + BT 4.0</td>
<td>710661-001</td>
<td></td>
</tr>
<tr>
<td>(14) <strong>Audio/USB board</strong></td>
<td>737732-001</td>
<td></td>
</tr>
<tr>
<td>(15) <strong>ExpressCard assembly</strong></td>
<td>737733-001</td>
<td></td>
</tr>
<tr>
<td>(16) <strong>Speaker assembly</strong></td>
<td>733638-001</td>
<td></td>
</tr>
<tr>
<td>(17) <strong>Smart card reader</strong> (includes cable)</td>
<td>742159-001</td>
<td></td>
</tr>
<tr>
<td>(18) <strong>Optical drive</strong> (includes bezel and bracket) supported in upgrade bay</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blu-ray R/RE DVD±R/W SuperMulti Double-Layer Drive</td>
<td>735600-001</td>
<td></td>
</tr>
<tr>
<td>Blu-ray ROM DVD±R/W SuperMulti Double-Layer Drive</td>
<td>735599-001</td>
<td></td>
</tr>
<tr>
<td>DVD±R/W SuperMulti Double-Layer Drive</td>
<td>735602-001</td>
<td></td>
</tr>
<tr>
<td>DVD-ROM Drive</td>
<td>735601-001</td>
<td></td>
</tr>
<tr>
<td>Also supported in upgrade bay:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>500 GB, 7200 rpm hard drive</td>
<td>703267-001</td>
<td></td>
</tr>
<tr>
<td>(19) <strong>Graphics card fan/heat sink assembly</strong> (includes replacement thermal material):</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use in models with the NVIDIA Quadro K5100M graphics card</td>
<td>735373-001</td>
<td></td>
</tr>
<tr>
<td>For use in models with the NVIDIA Quadro K4100M or K3100M graphics card</td>
<td>735374-001</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td></td>
<td>For use in models with the NVIDIA Quadro K610M graphics card</td>
<td>735375-001</td>
</tr>
<tr>
<td>20</td>
<td><strong>Processor heat sink</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For use only with computer models equipped with dual-core processors</td>
<td>735371-001</td>
</tr>
<tr>
<td></td>
<td>For use only with computer models equipped with quad-core processors</td>
<td>735372-001</td>
</tr>
<tr>
<td>21</td>
<td><strong>Battery</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8-cell, Li-ion, 2.8 Ah (83 WWh)</td>
<td>708456-001</td>
</tr>
<tr>
<td></td>
<td>8-cell, Li-ion, 2.8 Ah (75 WWh)</td>
<td>708455-001</td>
</tr>
<tr>
<td>22</td>
<td><strong>Base enclosure</strong> (includes latches)</td>
<td>733641-001</td>
</tr>
<tr>
<td>23</td>
<td><strong>Hard drive</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare part number 734280-001.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 TB, 5400-rpm, 2.5-in</td>
<td>676521-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 7200-rpm, 2.5-in</td>
<td>633252-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200-rpm, 7 mm</td>
<td>703267-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200-rpm, SED (Self-Encrypting Drive), 7 mm</td>
<td>703268-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 5400-rpm, FIPS, 7 mm</td>
<td>730946-001</td>
</tr>
<tr>
<td></td>
<td>320 GB, 7200-rpm, 2.5-in</td>
<td>603783-001</td>
</tr>
<tr>
<td>24</td>
<td><strong>RTC battery</strong></td>
<td>734300-001</td>
</tr>
<tr>
<td>25</td>
<td><strong>Service door</strong></td>
<td>733635-001</td>
</tr>
</tbody>
</table>
## Display components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
</table>
| (1)  | **Display bezel**  
For use in models with a webcam | 733633-001 |
<p>|      | For use in models without a webcam | 735589-001 |
| (2)  | <strong>Display panel cable</strong> (includes webcam module cable) | 740714-001 (Cable Kit) |
|      | <strong>Display Hinge Kit</strong>, includes: | 733634-001 |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3a)</td>
<td>Left and right hinges</td>
<td></td>
</tr>
<tr>
<td>(3b)</td>
<td>Clutch cover</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Brackets (not illustrated)</td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td>Webcam module</td>
<td>734295-001</td>
</tr>
<tr>
<td></td>
<td>Microphone module (not illustrated)</td>
<td>735370-001</td>
</tr>
<tr>
<td>(5)</td>
<td>Raw display panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>43.9 cm</strong> (17.3 in), HD+, anti-glare, LED, WVA</td>
<td>735366-001</td>
</tr>
<tr>
<td></td>
<td><strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, WVA</td>
<td>735367-001</td>
</tr>
<tr>
<td></td>
<td>Raw panel support kit, includes:</td>
<td>735590-001</td>
</tr>
<tr>
<td>(6)</td>
<td>WLAN antennas</td>
<td></td>
</tr>
<tr>
<td>(7)</td>
<td>WWAN antennas</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mylar screw covers (not illustrated)</td>
<td></td>
</tr>
<tr>
<td>(8)</td>
<td>Display enclosure</td>
<td>740477-001</td>
</tr>
</tbody>
</table>

Also available in raw panel support kit, spare part number 735590-001.
### Plastics Kit

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plastics Kit</td>
<td></td>
<td>733637-001</td>
</tr>
<tr>
<td>(1)</td>
<td>Rear cover, right</td>
<td></td>
</tr>
<tr>
<td>(2)</td>
<td>Rear cover, left</td>
<td></td>
</tr>
<tr>
<td>(3)</td>
<td>Fingerprint reader bracket</td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td>SD card reader insert</td>
<td></td>
</tr>
<tr>
<td>(5)</td>
<td>ExpressCard insert</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fingerprint reader insert (not illustrated)</td>
<td></td>
</tr>
</tbody>
</table>
## Cable Kit

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Cable Kit</strong></td>
<td>740714-001</td>
</tr>
<tr>
<td>(1)</td>
<td>Display/webcam cable</td>
<td></td>
</tr>
<tr>
<td>(2)</td>
<td>LVDS board cable</td>
<td></td>
</tr>
<tr>
<td>(3)</td>
<td>Power cable</td>
<td></td>
</tr>
</tbody>
</table>
# Bracket Kit

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bracket Kit</td>
<td></td>
<td>737734-001</td>
</tr>
<tr>
<td>(1)</td>
<td>Security lock/power connector bracket</td>
<td></td>
</tr>
<tr>
<td>(2)</td>
<td>RJ-45 bracket</td>
<td></td>
</tr>
<tr>
<td>(3)</td>
<td>Fingerprint reader bracket</td>
<td></td>
</tr>
</tbody>
</table>
## Mass storage devices

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Solid-state drive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SSD:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 256 GB, Self-Encrypting drive (SED)</td>
<td>737346-001</td>
</tr>
<tr>
<td></td>
<td>● 180 GB</td>
<td>737345-001</td>
</tr>
<tr>
<td></td>
<td>● 128 GB</td>
<td>737344-001</td>
</tr>
<tr>
<td></td>
<td>mSATA SSD:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 128 GB</td>
<td>737343-001</td>
</tr>
<tr>
<td></td>
<td>● 32 GB</td>
<td>737342-001</td>
</tr>
<tr>
<td>(2a)</td>
<td>Hard drive bracket</td>
<td>734280-001</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 734280-001.</td>
<td></td>
</tr>
<tr>
<td>(2b)</td>
<td>Hard drive (7.0 mm [0.28 in], 9.5 mm [0.37 in], or 12.7 mm [0.5 in]):</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 TB, 5400-rpm, 2.5-in</td>
<td>676521-001</td>
</tr>
<tr>
<td></td>
<td>750 GB, 7200-rpm, 2.5-in</td>
<td>633252-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200-rpm, 7 mm</td>
<td>703267-001</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>500 GB, 7200-rpm, SED (Self-Encrypting Drive), 7 mm</td>
<td>703268-001</td>
</tr>
<tr>
<td></td>
<td>500 GB, 5400-rpm, FIPS, 7 mm</td>
<td>730946-001</td>
</tr>
<tr>
<td></td>
<td>320 GB, 7200-rpm, 2.5-in</td>
<td>603783-001</td>
</tr>
<tr>
<td>(3)</td>
<td><strong>Optical drive</strong> (includes bezel, bracket, and screws)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive</td>
<td>735600-001</td>
</tr>
<tr>
<td></td>
<td>DVD±RW SuperMulti Double-Layer Drive</td>
<td>735599-001</td>
</tr>
<tr>
<td></td>
<td>Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive</td>
<td>735602-001</td>
</tr>
<tr>
<td></td>
<td>DVD-ROM Drive</td>
<td>735601-001</td>
</tr>
</tbody>
</table>
## Miscellaneous parts

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP USB laser mouse</td>
<td>674318-001</td>
</tr>
<tr>
<td>Cable lock for use on the docking station</td>
<td>575921-001</td>
</tr>
<tr>
<td>AC Adapter</td>
<td></td>
</tr>
<tr>
<td>200W PFC Slim AC Smart Adapter</td>
<td>693708-001</td>
</tr>
<tr>
<td>230W PFC Slim AC Smart Adapter</td>
<td>693706-001</td>
</tr>
<tr>
<td>Power cord (3 conductor, black, <strong>1.83 m</strong>):</td>
<td></td>
</tr>
<tr>
<td>For use in Argentina</td>
<td>491683-D01</td>
</tr>
<tr>
<td>For use in APD</td>
<td>491683-D91</td>
</tr>
<tr>
<td>For use in Australia</td>
<td>491683-D11</td>
</tr>
<tr>
<td>For use in Brazil</td>
<td>491683-D12</td>
</tr>
<tr>
<td>For use in the People's Republic of China</td>
<td>491683-AA1</td>
</tr>
<tr>
<td>For use in Denmark</td>
<td>491683-081</td>
</tr>
<tr>
<td>For use in India</td>
<td>491683-D61</td>
</tr>
<tr>
<td>For use in Israel</td>
<td>491683-8B1</td>
</tr>
<tr>
<td>For use in Italy</td>
<td>491683-D61</td>
</tr>
<tr>
<td>For use in Japan</td>
<td>491683-291</td>
</tr>
<tr>
<td>For use in the Netherlands</td>
<td>491683-891</td>
</tr>
<tr>
<td>For use in North America</td>
<td>491683-001</td>
</tr>
<tr>
<td>For use in Saudi Arabia</td>
<td>491683-171</td>
</tr>
<tr>
<td>For use in Singapore</td>
<td>491683-AF1</td>
</tr>
<tr>
<td>For use in South Africa</td>
<td>491683-AR1</td>
</tr>
<tr>
<td>For use in South Korea</td>
<td>491683-291</td>
</tr>
<tr>
<td>For use in Switzerland</td>
<td>491683-111</td>
</tr>
<tr>
<td>For use in Taiwan</td>
<td>491683-AB1</td>
</tr>
<tr>
<td>For use in Thailand</td>
<td>491683-281</td>
</tr>
<tr>
<td>For use in the United Kingdom and Singapore</td>
<td>491683-031</td>
</tr>
<tr>
<td><strong>Hard Drive Hardware Kit</strong> (includes hard drive bracket and screws)</td>
<td>734280-001</td>
</tr>
<tr>
<td><strong>Screw Kit</strong></td>
<td>741619-001</td>
</tr>
</tbody>
</table>
## Sequential part number listing

CSR flag designations:

- **A** = Mandatory
- **B** = Optional
- **C** = Service technician recommended
- **N** = Non-user replaceable

<table>
<thead>
<tr>
<th>Spare part number</th>
<th>CSR flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>491683-001</td>
<td>A</td>
<td>Power cord for use in North America (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-011</td>
<td>A</td>
<td>Power cord for use in Australia (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-031</td>
<td>A</td>
<td>Power cord for use in Singapore and the United Kingdom (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-061</td>
<td>A</td>
<td>Power cord for use in Italy (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-081</td>
<td>A</td>
<td>Power cord for use in Denmark (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-111</td>
<td>A</td>
<td>Power cord for use in Switzerland (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-171</td>
<td>A</td>
<td>Power cord for use in Saudi Arabia (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-201</td>
<td>A</td>
<td>Power cord for use in Thailand (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-202</td>
<td>A</td>
<td>Power cord for use in Brazil (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-291</td>
<td>A</td>
<td>Power cord for use in Japan (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-AA1</td>
<td>A</td>
<td>Power cord for use in the People’s Republic of China (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-AB1</td>
<td>A</td>
<td>Power cord for use in the Taiwan a (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-AD1</td>
<td>A</td>
<td>Power cord for use in South Korea (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-AF1</td>
<td>A</td>
<td>Power cord for use in Singapore (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-AR1</td>
<td>A</td>
<td>Power cord for use in South Africa (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-B91</td>
<td>A</td>
<td>Power cord for use in the Netherlands (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-BB1</td>
<td>A</td>
<td>Power cord for use in Israel (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-D01</td>
<td>A</td>
<td>Power cord for use in Argentina (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-D61</td>
<td>A</td>
<td>Power cord for use in India (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>491683-D91</td>
<td>A</td>
<td>Power cord for use in APD (3 conductor, black, 1.83 m)</td>
</tr>
<tr>
<td>575921-001</td>
<td>A</td>
<td>Cable lock for use on the docking station</td>
</tr>
<tr>
<td>603783-001</td>
<td>A</td>
<td>Hard drive, 320 GB, 7200-rpm, 2.5-in</td>
</tr>
<tr>
<td>633252-001</td>
<td>A</td>
<td>Hard drive, 750 GB, 7200-rpm, 2.5-in</td>
</tr>
<tr>
<td>670292-001</td>
<td>A</td>
<td>Intel Centrino Advanced-N 6235</td>
</tr>
<tr>
<td>Spare part number</td>
<td>CSR flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>674318-001</td>
<td>A</td>
<td>HP USB laser mouse</td>
</tr>
<tr>
<td>676521-001</td>
<td>A</td>
<td>Hard drive, 1-TB, 5400-rpm, 2.5-in</td>
</tr>
<tr>
<td>691740-001</td>
<td>A</td>
<td>Memory module, 4GB (PC3L-12800, 1600 MHz)</td>
</tr>
<tr>
<td>693374-001</td>
<td>A</td>
<td>Memory module, 8 GB (PC3L-12800, 1600 MHz)</td>
</tr>
<tr>
<td>693706-001</td>
<td>A</td>
<td>AC adapter, 230 W PFC AC Smart adapter</td>
</tr>
<tr>
<td>693708-001</td>
<td>A</td>
<td>AC adapter, 200 W PFC Slim AC Smart adapter</td>
</tr>
<tr>
<td>695915-001</td>
<td>A</td>
<td>Intel Centrino Advanced-N 6205, 802.11a/b/g/n WLAN module</td>
</tr>
<tr>
<td>703267-001</td>
<td>A</td>
<td>Hard drive, 500-GB, 7200-rpm, 7 mm</td>
</tr>
<tr>
<td>703268-001</td>
<td>A</td>
<td>Hard drive, 500-GB, 7200-rpm, SED, 7 mm</td>
</tr>
<tr>
<td>704030-001</td>
<td>A</td>
<td>HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module</td>
</tr>
<tr>
<td>704031-001</td>
<td>A</td>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
</tr>
<tr>
<td>708455-001</td>
<td>A</td>
<td>Battery, 8-cell, Li-ion, 2.8 Ah (75 WHr)</td>
</tr>
<tr>
<td>708456-001</td>
<td>A</td>
<td>Battery, 8-cell, Li-ion, 2.8 Ah (83 WHr)</td>
</tr>
<tr>
<td>710661-001</td>
<td>A</td>
<td>Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + BT 4.0</td>
</tr>
<tr>
<td>723521-002</td>
<td>N</td>
<td>Intel Core i7-4700MQ processor, 2.40 GHz (Turbo up to 3.40 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td>723523-002</td>
<td>N</td>
<td>Intel Core i7-4900MQ processor, 2.80 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td>723524-002</td>
<td>N</td>
<td>Intel Core i7-4800MQ processor, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
</tr>
<tr>
<td>723895-001</td>
<td>A</td>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
</tr>
<tr>
<td>728554-001</td>
<td>C</td>
<td>Graphics board, NVIDIA Quadro K610M, 1 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td>728555-001</td>
<td>C</td>
<td>Graphics board, NVIDIA Quadro K5100M, 8 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td>728556-001</td>
<td>C</td>
<td>Graphics board, NVIDIA Quadro K4100M, 4 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td>728557-001</td>
<td>C</td>
<td>Graphics board, NVIDIA Quadro K3100M, 4 GB dedicated GDDR5 video memory</td>
</tr>
<tr>
<td>730946-001</td>
<td>A</td>
<td>500 GB, 5400-rpm hard drive, FIPS, 7 mm</td>
</tr>
<tr>
<td>733633-001</td>
<td>C</td>
<td>Display bezel for use in models with a webcam</td>
</tr>
<tr>
<td>733634-001</td>
<td>C</td>
<td>Display Hinge Kit (includes left and right hinges, hinge cover, and bracket)</td>
</tr>
<tr>
<td>733635-001</td>
<td>A</td>
<td>Service door</td>
</tr>
<tr>
<td>733636-001</td>
<td>A</td>
<td>Power button board (includes cable)</td>
</tr>
<tr>
<td>733637-001</td>
<td>A</td>
<td>Plastics Kit</td>
</tr>
<tr>
<td>733638-001</td>
<td>C</td>
<td>Speaker assembly</td>
</tr>
<tr>
<td>733639-001</td>
<td>C</td>
<td>Multifunction board (includes LED light pipe)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>CSR flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>733641-001</td>
<td>N</td>
<td>Base enclosure (includes latches)</td>
</tr>
<tr>
<td>733688-001</td>
<td>A</td>
<td>Keyboard for use in the United States (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-031</td>
<td>A</td>
<td>Keyboard for use in The United Kingdom and Singapore (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-041</td>
<td>A</td>
<td>Keyboard for use in Germany (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-051</td>
<td>A</td>
<td>Keyboard for use in France (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-061</td>
<td>A</td>
<td>Keyboard for use in Italy (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-071</td>
<td>A</td>
<td>Keyboard for use in Spain (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-081</td>
<td>A</td>
<td>Keyboard for use in Denmark (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-091</td>
<td>A</td>
<td>Keyboard for use in Norway (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-131</td>
<td>A</td>
<td>Keyboard for use in Portugal (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-141</td>
<td>A</td>
<td>Keyboard for use in Turkey (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-151</td>
<td>A</td>
<td>Keyboard for use in Greece (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-161</td>
<td>A</td>
<td>Keyboard for use in Latin America (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-171</td>
<td>A</td>
<td>Keyboard for use in Saudi Arabia (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-201</td>
<td>A</td>
<td>Keyboard for use in Brazil (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-211</td>
<td>A</td>
<td>Keyboard for use in Hungary (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-251</td>
<td>A</td>
<td>Keyboard for use in Russia (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-261</td>
<td>A</td>
<td>Keyboard for use in Bulgaria (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-271</td>
<td>A</td>
<td>Keyboard for use in Romania (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-281</td>
<td>A</td>
<td>Keyboard for use in Thailand (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-291</td>
<td>A</td>
<td>Keyboard for use in Japan (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-A41</td>
<td>A</td>
<td>Keyboard for use in Belgium (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-AB1</td>
<td>A</td>
<td>Keyboard for use in Taiwan (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-AD1</td>
<td>A</td>
<td>Keyboard for use in South Korea (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-B31</td>
<td>A</td>
<td>Keyboard for use internationally (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-B71</td>
<td>A</td>
<td>Keyboard for use in Finland and Sweden (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-BA1</td>
<td>A</td>
<td>Keyboard for use in Slovenia (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-BB1</td>
<td>A</td>
<td>Keyboard for use in Israel (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-BG1</td>
<td>A</td>
<td>Keyboard for use in Switzerland (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-D61</td>
<td>A</td>
<td>Keyboard for use in India (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-DB1</td>
<td>A</td>
<td>Keyboard for use in Canada (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-DD1</td>
<td>A</td>
<td>Keyboard for use in Iceland (includes pointing stick and cables)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>CSR flag</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>733688-FL1</td>
<td>A</td>
<td>Keyboard for use in Czechoslovakia (includes pointing stick and cables)</td>
</tr>
<tr>
<td>733688-FP1</td>
<td>A</td>
<td>Keyboard for use in Northwest Africa (includes pointing stick and cables)</td>
</tr>
<tr>
<td>734280-001</td>
<td>A</td>
<td>Hard Drive Hardware Kit (includes hard drive bracket and screws)</td>
</tr>
<tr>
<td>734295-001</td>
<td>N</td>
<td>Webcam module with microphone</td>
</tr>
<tr>
<td>734300-001</td>
<td>N</td>
<td>RTC battery</td>
</tr>
<tr>
<td>735099-002</td>
<td>N</td>
<td>Intel Core i7-4930MX processor, 3.00 GHz (Turbo up to 3.90 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 57W</td>
</tr>
<tr>
<td>735366-001</td>
<td>C</td>
<td>Raw display panel, <strong>43.9 cm</strong> (17.3 in), HD+, anti-glare, LED, WVA</td>
</tr>
<tr>
<td>735367-001</td>
<td>C</td>
<td>Raw display panel, <strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, WVA</td>
</tr>
<tr>
<td>735368-001</td>
<td>N</td>
<td>Display assembly, <strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models without a webcam</td>
</tr>
<tr>
<td>735369-001</td>
<td>N</td>
<td>Display assembly, <strong>43.9 cm</strong> (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models with a webcam</td>
</tr>
<tr>
<td>735370-001</td>
<td>B</td>
<td>Microphone module</td>
</tr>
<tr>
<td>735371-001</td>
<td>C</td>
<td>Processor heat sink for use only with computer models equipped with dual-core processors (includes replacement thermal material)</td>
</tr>
<tr>
<td>735372-001</td>
<td>C</td>
<td>Processor heat sink for use only with computer models equipped with quad-core processors (includes replacement thermal material)</td>
</tr>
<tr>
<td>735373-001</td>
<td>C</td>
<td>Graphics card fan/heat sink assembly for use in models with the NVIDIA Quadro K5100M graphics card</td>
</tr>
<tr>
<td>735374-001</td>
<td>C</td>
<td>Graphics card fan/heat sink assembly for use in models with the NVIDIA Quadro K4100M or K3100M graphics card</td>
</tr>
<tr>
<td>735375-001</td>
<td>C</td>
<td>Graphics card fan/heat sink assembly for use in models with the NVIDIA Quadro K610M graphics card</td>
</tr>
<tr>
<td>735376-001</td>
<td>B</td>
<td>Top cover</td>
</tr>
<tr>
<td>735390-001</td>
<td>C</td>
<td>Raw Panel Support Kit (includes display enclosure, WLAN antennas, WWAN antennas, and Mylar screw covers)</td>
</tr>
<tr>
<td>735592-001</td>
<td>N</td>
<td>System board for use in non-Windows 8 models (includes replacement thermal material)</td>
</tr>
<tr>
<td>735592-501</td>
<td>N</td>
<td>System board for use in Windows 8 Standard models (includes replacement thermal material)</td>
</tr>
<tr>
<td>735592-601</td>
<td>N</td>
<td>System board for use in Windows 8 Professional models (includes replacement thermal material)</td>
</tr>
<tr>
<td>735599-001</td>
<td>A</td>
<td>Optical drive, Blu-ray ROM DVDs±RW SuperMulti Double-Layer Drive (includes bezel, bracket, and screws)</td>
</tr>
<tr>
<td>735600-001</td>
<td>A</td>
<td>Optical drive, Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive (includes bezel, bracket, and screws)</td>
</tr>
<tr>
<td>735601-001</td>
<td>A</td>
<td>DVD-ROM Drive (includes bezel, bracket, and screws)</td>
</tr>
<tr>
<td>Spare part number</td>
<td>CSR flag</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>735602-001</td>
<td>A</td>
<td>Optical drive, DVD±RW SuperMulti Double-Layer Drive (includes bezel, bracket, and screws)</td>
</tr>
<tr>
<td>737330-002</td>
<td>N</td>
<td>Intel Core i7-4600M processor, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td>737342-001</td>
<td>A</td>
<td>32-GB Solid-state drive, mSATA</td>
</tr>
<tr>
<td>737343-001</td>
<td>A</td>
<td>128-GB Solid-state drive, mSATA</td>
</tr>
<tr>
<td>737344-001</td>
<td>A</td>
<td>128-GB Solid-state drive</td>
</tr>
<tr>
<td>737345-001</td>
<td>A</td>
<td>180-GB Solid-state drive</td>
</tr>
<tr>
<td>737346-001</td>
<td>A</td>
<td>256-GB Solid-state drive</td>
</tr>
<tr>
<td>737730-001</td>
<td>B</td>
<td>Fingerprint reader (includes cable)</td>
</tr>
<tr>
<td>737732-001</td>
<td>C</td>
<td>Audio/USB board</td>
</tr>
<tr>
<td>737733-001</td>
<td>C</td>
<td>ExpressCard assembly</td>
</tr>
<tr>
<td>737734-001</td>
<td>N</td>
<td>Bracket Kit</td>
</tr>
<tr>
<td>738201-002</td>
<td>N</td>
<td>Intel Core i5-4330M processor, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td>738309-002</td>
<td>N</td>
<td>Intel Core i5-4300M processor, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
</tr>
<tr>
<td>740477-001</td>
<td>N</td>
<td>Display enclosure</td>
</tr>
<tr>
<td>740714-001</td>
<td>N</td>
<td>Cable Kit</td>
</tr>
<tr>
<td>741282-001</td>
<td>N</td>
<td>LVDS board</td>
</tr>
<tr>
<td>741619-001</td>
<td>A</td>
<td>Screw Kit</td>
</tr>
<tr>
<td>742159-001</td>
<td>C</td>
<td>Smart Card reader (includes cable)</td>
</tr>
</tbody>
</table>
4 Removal and replacement procedures preliminary requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

- Flat-bladed screwdriver
- Magnetic screwdriver
- Phillips P0 and P1 screwdrivers
- Torx T8 screwdriver
- 5.0 mm hex socket driver

Service considerations
The following sections include some of the considerations that you must keep in mind during disassembly and assembly procedures.

**NOTE:** As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and pointing stick connectors

**CAUTION:** When servicing the computer, be sure that cables are placed in their proper locations during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily.

**Drive handling**

⚠️ **CAUTION:** Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label the package “FRAGILE.”

**Grounding guidelines**

**Electrostatic discharge damage**

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the degree of sensitivity. Networks built into many integrated and pointing stick circuits provide some protection, but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and and pointing stick can work perfectly throughout a normal cycle. Or the device may function normally for a while, then degrade in the internal layers, reducing its life expectancy.
To prevent damage to the computer when you are removing or installing internal components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in this section.

Avoid touching pins, leads, and pointing stick circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

A product can be degraded by as little as 700 V.

### Typical electrostatic voltage levels

<table>
<thead>
<tr>
<th>Event</th>
<th>10%</th>
<th>40%</th>
<th>55%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walking across carpet</td>
<td>35,000 V</td>
<td>15,000 V</td>
<td>7,500 V</td>
</tr>
<tr>
<td>Walking across vinyl floor</td>
<td>12,000 V</td>
<td>6,000 V</td>
<td>3,000 V</td>
</tr>
<tr>
<td>Motions of bench worker</td>
<td>6,000 V</td>
<td>800 V</td>
<td>400 V</td>
</tr>
<tr>
<td>Removing DIPS from plastic tube</td>
<td>2,000 V</td>
<td>700 V</td>
<td>400 V</td>
</tr>
<tr>
<td>Removing DIPS from vinyl tray</td>
<td>11,500 V</td>
<td>4,000 V</td>
<td>2,000 V</td>
</tr>
<tr>
<td>Removing DIPS from Styrofoam</td>
<td>14,500 V</td>
<td>5,000 V</td>
<td>2,500 V</td>
</tr>
<tr>
<td>Removing bubble pack from PCB</td>
<td>26,500 V</td>
<td>20,000 V</td>
<td>7,000 V</td>
</tr>
<tr>
<td>Packing PCBs in foam-lined box</td>
<td>21,000 V</td>
<td>11,000 V</td>
<td>5,000 V</td>
</tr>
</tbody>
</table>

### Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

- To avoid hand and pointing stick contact, transport products in static-safe tubes, bags, or boxes.
- Protect ESD-sensitive parts and assemblies with conductive or approved and pointing stick containers or packaging.
- Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
- Place items on a grounded surface before removing items from their containers.
- Always be properly grounded when touching a component or assembly.
● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and pointing stick conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment used for moving materials is wired to ground and that proper materials are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

**Workstation guidelines**

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.

● Keep the work area free of non conductive materials, such as ordinary plastic assembly aids and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items only at static-free workstations.

● Avoid and pointing stick contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.

**Equipment guidelines**

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a minimum of one megohm ±10% resistance in the ground and pointing stick cords. To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at standing workstations and are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the operator and ground. To be effective, the conductive strips must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids
- Nonconductive foam
- Conductive tabletop workstations with ground and pointing stick cords of one megohm resistance
- Static-dissipative tables or floor mats with hard ties to the ground
- Field service kits
- Static awareness labels
- Material-handling packages
- Non conductive plastic bags, tubes, or boxes
- Metal tote boxes
- Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

<table>
<thead>
<tr>
<th>Material</th>
<th>Use</th>
<th>Voltage protection level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antistatic plastic</td>
<td>Bags</td>
<td>1,500 V</td>
</tr>
<tr>
<td>Carbon-loaded plastic</td>
<td>Floor mats</td>
<td>7,500 V</td>
</tr>
<tr>
<td>Metallized laminate</td>
<td>Floor mats</td>
<td>5,000 V</td>
</tr>
</tbody>
</table>
5 Removal and replacement procedures for Customer Self-Repair parts

⚠️ CAUTION: The Customer Self-Repair program is not available in all locations. Installing a part not supported by the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer Self-Repair is supported in your location.

Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 120 screws that must be removed, replaced, or loosened when servicing the computer. Make special note of each screw size and location during removal and replacement.

Battery

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-cell, Li-ion 2.8 Ah (83 WHr)</td>
<td>708456-001</td>
</tr>
<tr>
<td>8-cell, Li-ion 2.8 Ah (75 WHr)</td>
<td>708455-001</td>
</tr>
</tbody>
</table>

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

Remove the battery:

1. Position the computer upside down on a flat surface, with the front toward you.

2. Slide the battery release latch (1) to release the battery.
3. Rotate the battery at an angle (2), and then remove the battery from the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.

**SIM**

A SIM slot is located in the battery bay.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the SIM:
To remove a SIM, press in on the SIM, and then remove it from the slot.

Install the SIM by inserting it into the SIM slot until you hear a click.

**Service door**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service door</td>
<td>733635-001</td>
</tr>
</tbody>
</table>

Before removing the service door, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see **Battery on page 46**).

Remove the service door:

1. Position the computer upside down on a flat surface with the front toward you.

2. With the battery bay toward you, slide the service door release latch to the left (1), and then remove the optional screw (2).
3. Slide the service door release latch to the left again (3), slide the service door forward (4), and then lift to remove the service door (5).

**NOTE:** If you do not want to use the optional screw, you can store it inside the service door.

Reverse this procedure to install the service door.

**Hard drives, primary and secondary**

**NOTE:** The hard drive bracket is included in the Hard Drive Hardware Kit, spare part number 734280-001.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 TB, 5400-rpm hard drive, 2.5-in</td>
<td>676521-001</td>
</tr>
<tr>
<td>750 GB, 7200-rpm, 2.5-in</td>
<td>633252-001</td>
</tr>
<tr>
<td>500 GB, 7200-rpm hard drive, 7 mm</td>
<td>703267-001</td>
</tr>
<tr>
<td>500 GB, 7200-rpm, SED hard drive, 7 mm</td>
<td>703268-001</td>
</tr>
<tr>
<td>500 GB, 5400-rpm hard drive, FIPS, 7 mm</td>
<td>730946-001</td>
</tr>
<tr>
<td>320 GB, 7200-rpm, 2.5-in</td>
<td>603783-001</td>
</tr>
<tr>
<td>256 GB solid-state drive, Self-encrypting Drive (SED)</td>
<td>737346-001</td>
</tr>
<tr>
<td>180 GB solid-state drive</td>
<td>737345-001</td>
</tr>
<tr>
<td>128 GB solid-state drive</td>
<td>737344-001</td>
</tr>
</tbody>
</table>
Before removing the primary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Position the computer upside down on a flat surface.

5. Remove the battery (see Battery on page 46).

6. Remove the service door (see Service door on page 48).

7. Loosen the 3 hard drive screws (1), and then unlock the latch (2).

8. Grasp the latch to pull the hard drive (3) out of the hard drive bay.

9. If it is necessary to remove the hard drive bracket, follow these steps:
   a. Remove the four Phillips M3.0x3.0 screws (1) that secure the hard drive bracket to the hard drive.
b. Separate the bracket from the hard drive (2).

Reverse this procedure to reassemble and install the hard drive.

**Solid-state drive (SSD) – mSATA**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>128 GB</td>
<td>737343-001</td>
</tr>
<tr>
<td>32 GB</td>
<td>737342-001</td>
</tr>
</tbody>
</table>

Before removing the solid-state drive module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see **Battery on page 46**).

5. Remove the service door (see **Service door on page 48**).

Remove the solid-state drive:

1. Remove the two Phillips PM2.0x3.0 screws (1) that secure the drive to the computer.
2. Slide the drive away to remove it from the socket (2).

Reverse this procedure to install the solid-state drive.

**WLAN module**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel® Centrino™ Advanced-N 6205, 802.11a/b/g/n WLAN module</td>
<td>695915-001</td>
</tr>
<tr>
<td>Intel Centrino Advanced-N 6235</td>
<td>670292-001</td>
</tr>
<tr>
<td>Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + BT 4.0</td>
<td>710661-001</td>
</tr>
</tbody>
</table>

**CAUTION:** The WLAN module and the WWAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

Remove the WLAN module:

1. Position the computer with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

   **NOTE:** The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable connects to the middle terminal on the WLAN module.

3. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the system board. (The WLAN module tilts up.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

   **NOTE:** WLAN modules are designed with a notch to prevent incorrect insertion of the WLAN module into the WLAN module slot.

Reverse this procedure to install the WLAN module.
**WWAN module**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP lt4111 LTE/EV-DO/HSPA+ Mobile Broadband Module</td>
<td>704030-001</td>
</tr>
<tr>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
<td>704031-001</td>
</tr>
<tr>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
<td>723895-001</td>
</tr>
</tbody>
</table>

⚠️ **CAUTION:** The WWAN module and the WLAN module are not interchangeable.

To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore device functionality, and then contact technical support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

   - **NOTE:** The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the Phillips PM2.0×3.0 screw (2) that secures the WWAN module to the system board. (The WWAN module tilts up.)
3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

Reverse this procedure to install the WWAN module.

**RTC battery**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTC battery</td>
<td>734300-001</td>
</tr>
</tbody>
</table>

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

Remove the RTC battery:

▲ Disconnect the RTC battery cable (1) from the system board and remove the RTC battery (2).

**NOTE:** You may need to remove some double-sided adhesive.

Reverse this procedure to install the RTC battery.
Optical drive

**NOTE:** The upgrade bay supports both optical drives and hard drives. If you switch from a hard drive to an optical drive in the upgrade bay, you will need to remove four additional screws that secure the hard drive carrier.

**NOTE:** All optical drive spare part kits include bezel, bracket, and screws.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive</td>
<td>735600-001</td>
</tr>
<tr>
<td>DVD±RW SuperMulti Double-Layer Drive</td>
<td>735602-001</td>
</tr>
<tr>
<td>Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive</td>
<td>735599-001</td>
</tr>
<tr>
<td>DVD-ROM Drive</td>
<td>735601-001</td>
</tr>
</tbody>
</table>

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see *Battery on page 46*).
5. Remove the service door (see *Service door on page 48*).

Remove the optical drive:

1. Position the computer with the front toward you.
2. Loosen the Phillips captive screw (1) that secures the optical drive to the computer.
3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the tab to the left to release the optical drive from the computer.
4. Remove the optical drive (3).

5. If it is necessary to replace the optical drive bracket:
   a. Position the optical drive with the rear toward you.
   b. Remove the two Phillips M2.0×3.0 screws (1) that secure the optical drive bracket to the optical drive.
   c. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
Upgrade bay hard drive

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Optical drives:</strong></td>
<td></td>
</tr>
<tr>
<td>Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive</td>
<td>735600-001</td>
</tr>
<tr>
<td>Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive</td>
<td>735599-001</td>
</tr>
<tr>
<td>DVD±RW SuperMulti Double-Layer Drive</td>
<td>735602-001</td>
</tr>
<tr>
<td>DVD-ROM Drive</td>
<td>735601-001</td>
</tr>
<tr>
<td><strong>Hard drives/Solid-state drives:</strong></td>
<td></td>
</tr>
<tr>
<td>750 GB, 7200-rpm, 2.5-in</td>
<td>633252-001</td>
</tr>
<tr>
<td>256-GB Solid-state drive (SSD), Self-encrypting drive (SED)</td>
<td>737346-001</td>
</tr>
</tbody>
</table>

Before removing the upgrade bay hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).

Remove the upgrade bay hard drive:

1. Position the computer with the front toward you.
2. Remove the four Phillips PM3.0×5.0 screws (1) that secure the upgrade bay hard drive carrier to the computer.
3. Loosen the captive Phillips screw (2) that secures the upgrade bay hard drive carrier to the computer, and then insert a flat-bladed screwdriver or similar tool into the upgrade bay hard drive tab access (3) and press the tab to the left to release the upgrade bay hard drive carrier from the computer (4).

4. Remove the 2 Phillips PM2.0×5.0 screws (1) that secure the top bracket to the hard drive carrier, and then remove the bracket from the carrier (2).

5. Remove the 4 Phillips PM2.5×3.0 screws (1) that secure the hard drive to the carrier, and then pull the hard drive away from the connector (2) to disengage it.
6. Remove the hard drive (3).

Reverse this procedure to reassemble and install the upgrade bay hard drive and upgrade bay hard drive carrier.
Expansion memory module

NOTE: The computer has four memory slots. Expansion memory slots are located in a compartment on the bottom of the computer. Primary memory slots are located under the keyboard. When you add or replace memory modules, slot 1 must be populated before slot 2 is populated.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>8192 MB memory module (PC3L-12800, 1600 MHz, DDR3)</td>
<td>693374-001</td>
</tr>
<tr>
<td>4096 MB memory module (PC3L-12800, 1600 MHz, DDR3)</td>
<td>691740-001</td>
</tr>
</tbody>
</table>

Before removing an expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).

Remove an expansion memory module:

1. Spread the retaining tabs (1) on each side of the expansion memory module slot to release the expansion memory module. (The edge of the module opposite the slot rises away from the computer.)
2. Remove the expansion memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch to prevent incorrect installation into the expansion memory module slots.

Reverse this procedure to install an expansion memory module.
## Keyboard

**NOTE:** For a detailed list of available keyboards, see Sequential part number listing on page 36.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard</td>
<td>733688-xx1</td>
</tr>
</tbody>
</table>

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

**NOTE:** The optical drive or hard drive carrier in the upgrade bay must be removed to remove the keyboard.

Remove the keyboard:

1. Position the computer upside down.
2. Loosen the two Phillips captive screws that secure the keyboard to the computer.

3. Position the computer on its side with the display open at a 90 degree angle.

4. A hole in the optical drive bay provides access to the back of the keyboard. Insert a tool or a finger through the hole in the optical drive bay and push to disengage the keyboard.

**NOTE:** You must remove the optical drive or upgrade hard drive before performing this procedure.
5. Position the computer right-side up and open it as far as possible.

6. Lift the top of the keyboard, and then place the keyboard upside down on the palm rest.

7. Disconnect the keyboard cable (1) and the pointing stick/backlight cable (2) from the system board.

8. Remove the keyboard from the computer (3).

Reverse this procedure to install the keyboard.

**Primary memory module**

**NOTE:** The computer has four memory slots. Expansion memory slots are located in a compartment on the bottom of the computer. Primary memory slots are located under the keyboard.

When you add or replace the primary memory modules, populate the bottom slot before the top slot.
Before removing a primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

Remove the primary memory module:

1. Spread the retaining tabs (1) on each side of the primary memory module slot to release the primary memory module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the primary memory module (2) by pulling the module away from the slot at an angle.

**NOTE:** Memory modules are designed with a notch to prevent incorrect installation into the primary memory module slots.

Reverse this procedure to install a primary memory module.
6 Removal and replacement procedures for Authorized Service Provider parts

⚠️ CAUTION: Components described in this chapter should only be accessed by an authorized service provider. Accessing these parts can damage the computer or void the warranty.

Component replacement procedures

注意事项：关于你的电脑，包括型号、序列号、产品密钥和保修期的信息可以在电脑底部的服务标签上找到。更多信息，请参见Service tag and PCID label on page 21。

此章节提供授权服务提供商仅适用的部件的移除和更换程序。

这些步骤中可能有92颗螺丝需要移除、更换或松开。移除和更换过程中请注意每一颗螺丝的大小和位置。

Display bezel

你可以移除显示边框、网络摄像头和显示面板，而无需将整块显示从电脑中移除（不适用于DreamColor或触摸屏显示）。

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display bezel for use with computer models with a webcam</td>
<td>733633-001</td>
</tr>
<tr>
<td>Display bezel for use in models without a webcam</td>
<td>735589-001</td>
</tr>
</tbody>
</table>

移除显示边框前，请遵循以下步骤：

1. 关闭计算机。如果不确定计算机是否已关机或处于休眠状态，请先将计算机打开，然后通过操作系统将其关机。
2. 断开所有与计算机连接的外部设备。
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the display bezel:

1. Position the computer upright and open it as far as possible.

2. Remove the screw covers (1) and the two Phillips PM2.0x7.0 screws (2) that secure the display bezel to the display enclosure.

   Screw covers are available in the Raw Panel Support Kit, spare part number 735590-001.

3. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom edge (3) of the display bezel until the bezel disengages from the display enclosure and then remove the bezel (4).

Reverse this procedure to install the display bezel.
Webcam module

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Webcam module with microphone</td>
<td>734295-001</td>
</tr>
<tr>
<td>Microphone module</td>
<td>735370-001</td>
</tr>
</tbody>
</table>

Before removing the webcam module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the display bezel (see Display bezel on page 67).

Remove the webcam module:

1. Disconnect the cable from the webcam (1).

2. Pry to remove the webcam module from the display enclosure (2). The webcam module is secured with adhesive.

Reverse this procedure to install the webcam module.
Display panel

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw display panel, 43.9 cm (17.3 in), HD+, anti-glare, LED, WVA</td>
<td>735366-001</td>
</tr>
<tr>
<td>Raw display panel, 43.9 cm (17.3 in), FHD, anti-glare, LED, WVA</td>
<td>735367-001</td>
</tr>
</tbody>
</table>

Before removing the display panel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the display bezel (see Display bezel on page 67).

Remove the display panel:

1. Remove the six Torx T8M2.5×7.0 screws (1) that secure the panel to the enclosure.

   **NOTE:** If tape secures the panel to the enclosure, lift the tape to disengage the panel from the enclosure.

2. Separate the top of the display panel from the top of the enclosure (2).
3. Lift the tape that covers the connector on the back of display panel (1), and then disconnect the display panel cable (2).

4. Remove the eight Phillips PM2.0×3.0 screws (1) that secure the panel to the hinges.

5. Slide the display panel up and out of the hinges (2).

To replace the remaining display components, you must remove the display from the computer. Reverse this procedure to install the display panel. For more information, see Display assembly on page 84.
Remove the top cover:

1. Position the computer upside down.

2. Remove the two Torx T8M2.5x11.0 screws (1) and the nine Torx T8M2.5x6.0 screws (2) that secure the base enclosure to the top cover.

---

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).
3. Remove the four Torx T8M2.5x5.0 screws inside the battery bay (1) and the three Torx T8M2.5x5.0 screws in the optical drive/upgrade drive bay (2).

4. Position the computer upright and open it as far as possible.

5. Disconnect the following cables:
   - (1) Function board
   - (2) Power button board cable
   - (3) TouchPad cable
   - (4) Fingerprint reader board

6. Starting at the top right, pry the top cover up to disengage it from the base enclosure (1).
7. Remove the top cover from the base enclosure (2).

Reverse this procedure to install the top cover.
Speaker assembly

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaker assembly</td>
<td>733638-001</td>
</tr>
</tbody>
</table>

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

Remove the speaker assembly:

1. Position the computer upright and open as far as possible.

2. Disconnect the speaker cable from the system board (1).

3. Remove the two Torx T8M2.5x4.0 screws (2) that secure the speaker assembly to the base enclosure.
4. Remove the speaker assembly (3).

Reverse this procedure to install the speaker assembly.
**Multifunction board**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multifunction board (includes LED light pipe)</td>
<td>733639-001</td>
</tr>
</tbody>
</table>

Before removing the multifunction board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72).

Remove the multifunction board:

1. Position the top cover upright with the front toward you.
2. Lift the multifunction board cable to disengage the adhesive that secures it to the top of the top cover.

3. Position the top cover upside down with the front toward you.

4. Remove the Phillips PM2.0x3.0 screw (1) that secures the multifunction board to the top cover.

5. Slide the cable through the slot in top cover (2).
6. Remove the board/cable assembly from the top cover (3).

Reverse this procedure to install the multifunction board.

**Touchpad**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touchpad (includes cable)</td>
<td>spared with top cover</td>
</tr>
</tbody>
</table>

Before removing the TouchPad, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see [Battery on page 46](#)).

5. Remove the service door (see [Service door on page 48](#)).

6. Remove the optical drive (see [Optical drive on page 57](#)) or upgrade bay hard drive (see [Upgrade bay hard drive on page 59](#)).

7. Remove the keyboard (see [Keyboard on page 63](#)).

8. Remove the top cover (see [Top cover on page 72](#)).
Remove the TouchPad:

1. Position the top cover upside down with the front toward you.

2. Disconnect the cable from TouchPad (1), and then lift the cable to disengage the adhesive that secures the cable to the TouchPad bracket (2).

3. Remove the three Phillips PM2.0×3.0 screws (3) that secure the TouchPad to the top cover.

4. Lift the TouchPad straight up and off the top cover (4).

Reverse this procedure to install the TouchPad onto the top cover.

**Fingerprint reader**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fingerprint reader (includes cable)</td>
<td>737730-001</td>
</tr>
</tbody>
</table>

Before removing the fingerprint reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see **Battery on page 46**).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72).

Remove the fingerprint reader:

1. Position the top cover upside down with the front toward you.
2. Remove the Phillips PM2.0×3.0 screw (1) that secures the fingerprint reader bracket to the top cover.
3. Pull the bracket from atop the fingerprint reader board (2).
4. Disengage the cable from adhesive that secures it to top cover (3).
   The fingerprint reader bracket is available in the Bracket Kit using spare part number 737734-001.
   The fingerprint reader bezel and insert are available in the Plastics Kit using spare part number 733637-001.
5. Lift the fingerprint reader from the top cover (4).

Reverse this procedure to install the fingerprint reader.
**Power button board**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button board (includes cable)</td>
<td>733636-001</td>
</tr>
</tbody>
</table>

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see [Battery on page 46](#)).
5. Remove the service door (see [Service door on page 48](#)).
6. Remove the optical drive (see [Optical drive on page 57](#)) or upgrade bay hard drive (see [Upgrade bay hard drive on page 59](#)).
7. Remove the keyboard (see [Keyboard on page 63](#)).
8. Remove the top cover (see [Top cover on page 72](#)).

Remove the power button board:

1. Position the top cover upside down with the front toward you.
2. Pull the cable through the slot in top cover (1).
3. Disengage the cable from adhesive that secures it to top cover (2).
4. Remove the Phillips PM2.0×3.0 screw (3) that secures the power button board to the top cover.
5. Lift the bottom (cable side) of the board up, and then pull the board out from under the tabs that secure it in place (4).

Reverse this procedure to install the power button board.
Display assembly

You can remove the display bezel, webcam, and display panel without removing the entire display from the computer on models with standard displays (not DreamColor or touchscreen displays). See Display bezel on page 67, Webcam module on page 69, and Display panel on page 70 earlier in this chapter for more information.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>43.9 cm (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models without a webcam</td>
<td>735368-001</td>
</tr>
<tr>
<td>43.9 cm (17.3 in), FHD, anti-glare, LED, UWVA, DreamColor for use in models with a webcam</td>
<td>735369-001</td>
</tr>
<tr>
<td>Display Hinge Kit (includes left and right hinges, hinge cover, and bracket)</td>
<td>733634-001</td>
</tr>
<tr>
<td>Raw Panel Support Kit (includes display enclosure, WLAN antennas, WWAN antennas, and Mylar screw covers)</td>
<td>735590-001</td>
</tr>
</tbody>
</table>

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72).

Remove the display assembly:

1. Position the computer upside down.
2. Remove the WLAN and WWAN antenna cables from the routing channel built into the bottom of the base enclosure.

3. Position the computer upright and open as far as possible.

4. Pull the WLAN and WWAN antenna cables through the hole in the upper right of the base enclosure.

5. Position the computer upright, closed, with the rear toward you.
6. Remove the four Torx T8M2.5x3.0 screws (1) that secure the clutch cover to the computer, and then lift the cover from the computer (2).

**NOTE:** The clutch cover is available using spare part number 733634-001.

7. Remove the two Torx T8M2.5x7.0 screws that secure the display panel to the computer.

8. Position the computer upright and open as far as possible.

**CAUTION:** Support the display assembly when removing the display screws in the following steps. Failure to support the display assembly can result in damage to the assembly and other components.

9. Remove the two Torx T8M2.0x5.0 screws (1) that secure the display panel cable bracket to the system board, and then lift the bracket off the system board (2).

10. Pull up on the display cable to disengage the adhesive that secures it to the base enclosure (3).
11. Disconnect the display cable from the system board (4).

12. Remove the two Torx T8M2.5x7.0 screws (1) that secure the display panel to the computer, and then lift the display panel off the computer (2).
13. Remove the six Torx T8M2.5×7.0 screws (1) that secure the panel to the enclosure.

**NOTE:** If tape secures the panel to the enclosure, lift the tape to disengage the panel from the enclosure.

14. Lift the top of the display panel, and then remove the panel from the enclosure (2).

15. If you need to remove the display hinge brackets from the display enclosure:

**NOTE:** Display hinge brackets are available in the Hinge Kit using spare part number 733634-001.

a. Remove the four Phillips PM2.0×3.0 screws (1) that secure the display panel to each hinge.

b. Remove the hinge brackets from the display panel (2).
16. If you need to remove the LVDS board from the display enclosure:

**NOTE:** The LVDS board is available using spare part number 741282-001.

a. Disconnect the display cable (1) and the LVDS board cable (2) from the board.

b. Remove the two Phillips PM1.5x3.0 screws (3) that secure the board to the display panel.

c. Lift the LVDS board from the display enclosure (4).

17. If you need to remove the display cable from the display enclosure:

**NOTE:** The display cable is available in the Cable Kit using spare part number 740714-001.

a. Release the adhesive (1) that secures the display panel cable to the display panel.
If you need to remove the antenna cables from the display enclosure:

- **a.** Lift the antennas from the routing paths on the display enclosure (1).
- **b.** Remove the WLAN antennas (2) and WWAN antennas from the enclosure (3).

Antenna cables are available in the Raw Panel Support Kit, spare part number 735590-001. The display enclosure is available using spare part number 740477-001.

Reverse this procedure to install the display assembly.
Before removing the ExpressCard assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

Remove the ExpressCard assembly:

1. Position the computer upright and open as far as possible.

2. Remove the Torx T8M2.5x4.0 screw (1) that secures the light pipe to the computer, and then lift the light pipe from the computer (2).

3. Remove the four Torx T8M2.5x4.0 screws (3) that secure the ExpressCard assembly to the computer.

4. Lift up on the right side of the board to disengage it from the system board connector (4), and then pull the assembly upward and to the right to remove it from the computer (5).
Reverse this procedure to install the ExpressCard assembly.

## Smart Card reader

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smart Card reader (includes cable)</td>
<td>742159-001</td>
</tr>
</tbody>
</table>

The Smart Card reader is located under the ExpressCard assembly.

Before removing the Smart Card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72).
9. Remove the ExpressCard assembly (see ExpressCard assembly on page 91).

Remove the Smart Card:

1. Position the computer upright and open as far as possible.
2. Remove the three Phillips PM2.5x4.0 screws (1) that secure the Smart Card reader to the computer.
3. Lift the Smart Card reader slightly upward and toward the left (2), and then disconnect the cable from the ZIF connector on the system board (3).
4. Remove the Smart Card reader from the computer (4).

Reverse this procedure to install the Smart Card reader.

**Audio/USB board**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio/USB board</td>
<td>737732-001</td>
</tr>
</tbody>
</table>

Before removing the audio/USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).
Remove the audio/USB board:

1. Position the computer upright and open as far as possible.

2. Remove the four Phillips M2.5x4.0 screws (1) that secure the audio/USB board to the base enclosure.

3. Lift up on the left side of the board to disengage it from the system board connector (2).

4. Pull the board up and toward the left to disengage the ports on the right side of the board from the base enclosure, and then remove it from the base enclosure (3).

Reverse this procedure to install the audio/USB board.
**Processor heat sink**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>For use only with computer models equipped with quad-core processors</td>
<td>735372-001</td>
</tr>
<tr>
<td>For use only with computer models equipped with dual-core processors</td>
<td>735371-001</td>
</tr>
</tbody>
</table>

Before removing the processor heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

Remove the processor heat sink:

1. Following the sequence stamped into the processor heat sink, loosen the four Phillips captive screws (1) that secure the processor heat sink to the system board.

   **NOTE:** If there is Mylar tape that secures the heat sink to the fan, lift up on the tape to disengage the heat sink.
2. Remove the heat sink from the base enclosure (2).

**NOTE:** Use the image below that best matches your model.
3. Thermal paste located on the surfaces of the processor (1) and the processor heat sink (2). Replacement thermal paste and pads are included in the processor heat sink and processor spare part kits.

Reverse this procedure to install the processor heat sink.
NOTE: The processor spare part kit includes replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel Core i7 processors (include replacement thermal material):</td>
<td></td>
</tr>
<tr>
<td>i7-4930MX, 3.00 GHz (Turbo up to 3.90 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 57W</td>
<td>735099-002</td>
</tr>
<tr>
<td>i7-4900MQ, 2.80 GHz (Turbo up to 3.80 GHz), 1600 MHz, 8 MB L3 Cache, 8 threads, 47W</td>
<td>723523-002</td>
</tr>
<tr>
<td>i7-4800MQ, 2.70 GHz (Turbo up to 3.70 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
<td>723524-002</td>
</tr>
<tr>
<td>i7-4700MQ, 2.40 GHz (Turbo up to 3.40 GHz), 1600 MHz, 6 MB L3 Cache, 8 threads, 47W</td>
<td>723521-002</td>
</tr>
<tr>
<td>i7-4600M, 2.90 GHz (Turbo up to 3.60 GHz), 1600 MHz, 4 MB L3 Cache, 4 threads, 37W</td>
<td>737330-002</td>
</tr>
<tr>
<td>Intel Core i5 processors (include replacement thermal material):</td>
<td></td>
</tr>
<tr>
<td>i5-4330M, 2.80 GHz (Turbo up to 3.50 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
<td>738201-002</td>
</tr>
<tr>
<td>i5-4300M, 2.60 GHz (Turbo up to 3.30 GHz), 1600 MHz, 3 MB L3 Cache, 4 threads, 37W</td>
<td>738309-002</td>
</tr>
</tbody>
</table>

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72).
9. Remove the processor heat sink (see Processor heat sink on page 95).

Remove the processor:
1. Use a Torx T8 screwdriver to turn the processor locking screw (1) one-half turn counterclockwise, until you hear a click.
2. Lift the processor (2) straight up and remove it.

**NOTE:** When you install the processor, the gold triangle (3) on the processor must be aligned with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
Graphics board fan/heat sink assembly

**NOTE:** The graphics board fan/heat sink assemblies include replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan/heat sink assembly for use in models with the NVIDIA Quadro K5100M graphics card</td>
<td>735373-001</td>
</tr>
<tr>
<td>Fan/heat sink assembly for use in models with the NVIDIA Quadro K4100M or K3100M graphics card</td>
<td>735374-001</td>
</tr>
<tr>
<td>Fan/heat sink assembly for use in models with the NVIDIA Quadro K610M graphics card</td>
<td>735375-001</td>
</tr>
</tbody>
</table>

**NOTE:** To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to turn on automatically when high temperature conditions exist. These conditions are affected by high external temperatures, system power consumption, power management/battery conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the graphics board heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 46).
5. Remove the service door (see service door).
6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).
7. Remove the keyboard (see Keyboard on page 63).
8. Remove the top cover (see Top cover on page 72)

Remove the graphics board fan/heat sink assembly:

1. Disconnect the fan cable from the system board (1).
2. If the processor heat sink is still installed and has Mylar tap connecting it to the fan, lift up on the tape to disengage it from the fan.
3. Following the sequence stamped into the graphics board heat sink, loosen the four Phillips captive Torx (2) that secure the graphics board heat sink/fan assembly to the system board.
4. Lift the heat sink/fan assembly (3) straight up to remove it.
5. Use the image below that matches your computer’s thermal pad configuration.

The thermal material must be thoroughly cleaned from the surfaces of the graphics board heat sink and the graphics board each time the graphics board heat sink is removed: Thermal material is used on the system board component closer to the fan (1) and the heat sink that services it (2), as well as on the graphics board (3) and various locations on the graphics board heat sink section (4) that services it.
Reverse this procedure to install the graphics board fan/heat sink assembly.

**Graphics board**

> **NOTE:** The graphics board spare part kit includes replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA Quadro K5100M, 8 GB dedicated GDDR5 video memory</td>
<td>728555-001</td>
</tr>
<tr>
<td>NVIDIA Quadro K4100M, 4 GB dedicated GDDR5 video memory</td>
<td>728556-001</td>
</tr>
<tr>
<td>NVIDIA Quadro K3100M, 4 GB dedicated GDDR5 video memory</td>
<td>728557-001</td>
</tr>
<tr>
<td>NVIDIA Quadro K610M, 1 GB dedicated GDDR5 video memory</td>
<td>728554-001</td>
</tr>
</tbody>
</table>

Before removing the graphics board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

9. Remove the graphics board fan/heat sink assembly (see Graphics board fan/heat sink assembly on page 100).

Remove the graphics board:

1. Remove the 2 Torx T8M2.5×4.0 screws (1) that secure the graphics board to the system board.

2. Lift the right edge of the graphics board until it rests at an angle (2), and then remove it from the connector (3).

Reverse this procedure to install the graphics board.
Power connector cable

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

9. Remove the display assembly (see Display assembly on page 84).

10. Remove the graphics board fan/heat sink (see Graphics board fan/heat sink assembly on page 100).

Remove the power connector cable:

1. Remove the Torx T8M2.5×7.0 screw (1) that secures to the left, rear plastic cover to the base enclosure, and the lift the plastic piece off the base enclosure (2).

   The left, rear plastic cover is available in the Plastics Kit using spare part number 733637-001.

2. Remove the Torx T8M2.5×4.0 screw (3) that secures to the bracket to the base enclosure, and the lift the bracket out of the base enclosure (4).

   The bracket is available in the Bracket Kit using spare part number 737734-001.

3. Disconnect the cable from the system board (5).
4. Remove the power connector cable from the base enclosure (6).

Reverse this procedure to install the power connector cable.

**System board**

**NOTE:** All system board spare part kits include replacement thermal material.

**NOTE:** Models that support quad-core processors have four memory slots. Models that support dual-core processors have two memory slots.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System board for use in non-Windows 8 models</td>
<td>735592-001</td>
</tr>
<tr>
<td>System board for use in models with Windows 8 Standard</td>
<td>735592-501</td>
</tr>
<tr>
<td>System board for use in models with Windows 8 Professional</td>
<td>735592-601</td>
</tr>
</tbody>
</table>

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).
5. Remove the service door (see Service door on page 48).

6. Remove the optical drive (see Optical drive on page 57) or upgrade bay hard drive (see Upgrade bay hard drive on page 59).

7. Remove the keyboard (see Keyboard on page 63).

8. Remove the top cover (see Top cover on page 72).

9. Remove the display assembly (see Display assembly on page 84).

10. Remove the graphics board fan/heat sink (see Graphics board fan/heat sink assembly on page 100).

11. Remove the processor heat sink (see Processor heat sink on page 95).

12. Remove the audio/USB board (see Audio/USB board on page 93).

13. Remove the Smart Card reader (see Smart Card reader on page 92).

14. Remove the Expresscard assembly (see ExpressCard assembly on page 91).

When replacing the system board, be sure that the following additional components are removed from the defective system board and installed on the replacement system board:

- SIM (see SIM on page 47)
- WLAN module (see WLAN module on page 52)
- WWAN module (see WWAN module on page 54)
- Solid-state drive (see Solid-state drive (SSD) – mSATA on page 51)
- Hard drives (see Hard drives, primary and secondary on page 49)
- Primary memory modules (see Primary memory module on page 65)
- Expansion memory modules (see Expansion memory module on page 62)
- Graphics board (see Graphics board on page 103)
- Processor (see Processor on page 98)

Remove the system board:

1. Pry off the plastic piece in the right rear corner above the RJ-45 connector (1).
2. Remove the Torx T8M2.5x4.0 screw that secures the bracket over the RJ-45 connector (2), and then lift the bracket off the connector (3).

The RJ-45 connector bracket is available in the Bracket Kit using spare part number 737734-001. The right rear plastic cover is available in the Plastics Kit using spare part number 733637-001.

3. Disconnect the power connector cable (1) and the speaker cable (2) from the system board.

4. Remove the six Torx T8M2.5x4.0 screws (marked with a triangle icon) (3) that secure the system board to the base enclosure.
5. Lift up on the left side of the system board (4), and then pull the system board up and to the left to remove it.

⚠️ **CAUTION:** The system board consists of very narrow areas. When lifting to remove it, be careful not to stress or bind and damage those narrow areas.

When replacing the system board, note the location of the thermal material on the system board (1) and the base enclosure (2).

Reverse this procedure to install the system board.
7 Computer Setup (BIOS), MultiBoot, and System Diagnostics in Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of devices installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press `f10` to enter Computer Setup.
Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

> **NOTE:** You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press `f10` to enter Computer Setup.
   - To select a menu or a menu item, use the `tab` key and the keyboard arrow keys and then press `enter`, or use a pointing device to click the item.
   - To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key on the keyboard.
   - To close open dialog boxes and return to the main Computer Setup screen, press `esc`, and then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:
   - To exit Computer Setup menus without saving your changes:
     - Click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
     - Or –
       - Use the `tab` key and the arrow keys to select **File > Ignore Changes and Exit**, and then press `enter`.
   - To save your changes and exit Computer Setup menus:
     - Click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
     - Or –
       - Use the `tab` key and the arrow keys to select **File > Save Changes and Exit**, and then press `enter`.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup

> **NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press `f10` to enter Computer Setup.
3. Use a pointing device or the arrow keys to select **File > Restore Defaults**.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select **File > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

**(NOTE:** Your password settings and security settings are not changed when you restore the default settings.**

---

**Updating the BIOS**

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named **Readme.txt**, which contains information regarding installing and troubleshooting the file.

**Determining the BIOS version**

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as **ROM date** and **System BIOS**) can be displayed by pressing **fn + esc** (if you are already in Windows) or by using Computer Setup.


2. Use a pointing device or the arrow keys to select **File > System Information**.

3. To exit Computer Setup without saving your changes, click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the **tab** key and the arrow keys to select **File > Ignore Changes and Exit**, and then press **enter**.

---

112 Chapter 7  Computer Setup (BIOS), MultiBoot, and System Diagnostics in Windows 8
Downloading a BIOS update

⚠️ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, select the HP Support Assistant app.

2. Select **Updates and tune-ups**, and then select **Check for HP updates now**.

3. At the download area, follow these steps:
   
   a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.

   b. Follow the on-screen instructions to download your selection to the hard drive.

      If the update is more recent than your BIOS, make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.

   ✂️ NOTE: If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

   BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the download is complete. If no instructions are displayed, follow these steps:

   1. From the Start screen, type `e`, and then click **File Explorer**.

   2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

   3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the update.

   4. Double-click the file that has an .exe extension (for example, `filename.exe`).

      The BIOS installation begins.

   5. Complete the installation by following the on-screen instructions.

   ✂️ NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.
Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

- To set a new boot order that the computer uses each time it is turned on, by changing the boot order in Computer Setup.
- To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options menu.
- To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.
4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.

— or —
To move the device down in the boot order, use a pointing device to click the down arrow, or press the - key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   – or –
   Use the arrow keys to select File > Save Changes and Exit, and then press enter.

**Dynamically choosing a boot device using the f9 prompt**

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
3. Use a pointing device or the arrow keys to select a boot device, then press enter.

**Setting a MultiBoot Express prompt**

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press enter.
4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)
5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   – or –
   Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

- To specify a boot device from the Express Boot menu, select your preference within the allotted time, and then press enter.
- To prevent the computer from defaulting to the current MultiBoot setting, press any key before the allotted time expires. The computer will not start until you select a boot device and press enter.
- To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to expire.

Using System Diagnostics

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is functioning properly. The following diagnostic tests may be available in System Diagnostics:

- System Tune-Up—This group of additional tests checks your computer to make sure that the main components are functioning correctly. System Tune-Up runs longer and more comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery calibration), video memory, and the WLAN module status.
- Start-up test—This test analyzes the main computer components that are required to start the computer.
- Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up test does not detect.
- Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the data to a good sector.
- Memory test—This test analyzes the physical condition of the memory modules. If it reports an error, replace the memory modules immediately.
- Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary. If the battery fails the test, contact HP support to report the issue and purchase a replacement battery.
- BIOS Management—You can update or rollback the version of the BIOS on the system. Do not shut down or remove external power during the process. You will be given a confirmation screen before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the System Diagnostics window.
To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

**NOTE:** If you need to stop a diagnostics test while it is running, press esc.
Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of devices installed, the startup sequence of the computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

   **NOTE:** You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press `f10` to enter Computer Setup.
   - To select a menu or a menu item, use the `tab` key and the keyboard arrow keys and then press `enter`, or use a pointing device to click the item.
   - To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key on the keyboard.
   - To close open dialog boxes and return to the main Computer Setup screen, press `esc`, and then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

- To exit Computer Setup menus without saving your changes:
  - Click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
  - or –
  - Use the `tab` key and the arrow keys to select **File > Ignore Changes and Exit**, and then press `enter`.

- To save your changes and exit Computer Setup menus:
  - Click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
  - or –
  - Use the `tab` key and the arrow keys to select **File > Save Changes and Exit**, and then press `enter`.

Your changes go into effect when the computer restarts.

Restoring default settings in Computer Setup

**NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press `f10` to enter Computer Setup.
3. Use a pointing device or the arrow keys to select **File > Restore Defaults**.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select **File > Save Changes and Exit**, and then press enter.

Your changes go into effect when the computer restarts.

**NOTE:** Your password settings and security settings are not changed when you restore the default settings.

---

**Updating the BIOS**

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called *SoftPaqs*.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

**Determining the BIOS version**

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as *ROM date* and *System BIOS*) can be displayed by pressing `fn + esc` (if you are already in Windows) or by using Computer Setup.


2. Use a pointing device or the arrow keys to select **File > System Information**.

3. To exit Computer Setup without saving your changes, click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the **tab** key and the arrow keys to select **File > Ignore Changes and Exit**, and then press enter.
**Downloading a BIOS update**

⚠️ **CAUTION:** To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

- Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
- Do not shut down the computer or initiate Sleep.
- Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting **Start > Help and Support**.
2. Select **Updates and tune-ups**, and then select **Check for HP updates now**.
3. At the download area, follow these steps:
   - **a.** Identify the most recent BIOS update and compare it to the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.
   - **b.** Follow the on-screen instructions to download your selection to the hard drive.
     - If the update is more recent than your BIOS, make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.

---

**NOTE:** If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the download is complete. If no instructions are displayed, follow these steps:

1. Select **Start > Computer**.
2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).
3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the update.
4. Double-click the file that has an .exe extension (for example, `filename.exe`).
   - The BIOS installation begins.
5. Complete the installation by following the on-screen instructions.

---

**NOTE:** After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.
Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

- To set a new boot order that the computer uses each time it is turned on, by changing the boot order in Computer Setup.
- To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options menu.
- To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select the Legacy Boot Order list, and then press enter.
4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.
   – or –
To move the device down in the boot order, use a pointing device to click the down arrow, or press the - key.

5. To save your changes and exit Computer Setup, click the **Save** icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select **File > Save Changes and Exit**, and then press **enter**.

**Dynamically choosing a boot device using the f9 prompt**

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing **esc** while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press **f9**.

3. Use a pointing device or the arrow keys to select a boot device, then press **enter**.

**Setting a MultiBoot Express prompt**

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press **esc** while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press **f10** to enter Computer Setup.

3. Use a pointing device or the arrow keys to select **System Configuration > Boot Options**, and then press **enter**.

4. In the **MultiBoot Express Popup Delay (Sec)** field, enter the length of time in seconds that you want the computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the **Save** icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select **File > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.
Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

- To specify a boot device from the Express Boot menu, select your preference within the allotted time, and then press enter.
- To prevent the computer from defaulting to the current MultiBoot setting, press any key before the allotted time expires. The computer will not start until you select a boot device and press enter.
- To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to expire.

Using HP PC Hardware Diagnostics (UEFI) (select models only)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic tests to determine if the computer hardware is functioning properly. The tool runs outside of the operating system to isolate hardware failures from issues that may be caused by the operating system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press esc, and then press f2.

   After pressing f2, the BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools in the following order:
   
   a. Connected USB drive
      
      NOTE: To download the HP PC Hardware Diagnostics (UEFI) tool to a USB drive, see Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 124.
   
   b. Hard drive
   
   c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

   NOTE: If you need to stop a diagnostic test while it is running, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.


2. Click Support & Drivers, and then click the Drivers & Software tab.

3. Enter the product name in the text box, and then click Search.
4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click **HP UEFI Support Environment**.
   
   – or –

   Click **Download**, and then select **Run**.
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of peripherals installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

### Starting Computer Setup

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press `F10` to enter Computer Setup.
Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
   - To select a menu or a menu item, use the `tab` key and the keyboard arrow keys and then press `enter`, or use a pointing device to click the item.
   - To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key.
   - To close open dialog boxes and return to the main Computer Setup screen, press `esc`, and then follow the on-screen instructions.

   **NOTE:** You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press `f10` to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

- To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
  - or –
  Use the `tab` key and the arrow keys to select File > Ignore Changes and Exit, and then press `enter`.
  - or –

- To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.
  - or –
  Use the `tab` key and the arrow keys to select File > Save Changes and Exit, and then press `enter`.

Your changes go into effect when the computer restarts.
Restoring default settings in Computer Setup

**NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press `f10` to enter Computer Setup.
3. Use a pointing device or the arrow keys to select **File > Restore Defaults**.
4. Follow the on-screen instructions.
5. To save your changes and exit, click the **Save** icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   - or -
   Use the arrow keys to select **File > Save Changes and Exit**, and then press `enter`.

Your changes go into effect when the computer restarts.

**NOTE:** Your password settings and security settings are not changed when you restore the default settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as **ROM date** and **System BIOS**) can be displayed as follows:

2. Use a pointing device or the arrow keys to select **File > System Information**.
3. To exit Computer Setup without saving your changes, click the **Exit** icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   - or -
   Use the **tab** key and the arrow keys to select **File > Ignore Changes and Exit**, and then press `enter`.
NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

⚠️ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.


2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to download.

3. Click the option for software and driver downloads, type your computer model number in the product box, and then press enter. Follow the on-screen instructions to identify your computer and access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

- **Start-up test**—This test analyzes the main computer components that are required to start the computer.

- **Run-in test**—This test repeats the start-up test and checks for intermittent problems that the start-up test does not detect.

- **Hard disk test**—This test analyzes the physical condition of the hard drive, and then checks all data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the data to a good sector.
- Memory test—This test analyzes the physical condition of the memory modules. If it reports an error, replace the memory modules immediately.

- Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary. If the battery fails the test, contact support to report the issue and purchase a replacement battery.

- System Tune-Up—This group of additional tests checks your computer to make sure that the main components are functioning correctly. System Tune-Up runs longer and more comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed, press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

**NOTE:** If you need to stop a diagnostics test while it is running, press esc.
## 10 Specifications

### Computer specifications

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>41.60 cm</td>
<td>16.37 in</td>
</tr>
<tr>
<td>Depth</td>
<td>27.20 cm</td>
<td>10.70 in</td>
</tr>
<tr>
<td>Height (front to back)</td>
<td>3.40 cm to 4.00 cm</td>
<td>1.33 in to 1.57 in</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>3.48 kg</td>
<td>7.67 lbs</td>
</tr>
<tr>
<td><strong>Input power</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating voltage</td>
<td>19.5 V dc @ 4.74 A – 120 W</td>
<td></td>
</tr>
<tr>
<td>Operating current</td>
<td>4.74 A</td>
<td></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>5°C to 35°C</td>
<td>41°F to 95°F</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>-20°C to 60°C</td>
<td>-4°F to 140°F</td>
</tr>
<tr>
<td><strong>Relative humidity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>10% to 90%</td>
<td>10% to 90%</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>5% to 95%</td>
<td>5% to 95%</td>
</tr>
<tr>
<td><strong>Maximum altitude</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>-15 m to 3,048 m</td>
<td>-50 ft to 10,000 ft</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>-15 m to 12,192 m</td>
<td>-50 ft to 40,000 ft</td>
</tr>
<tr>
<td><strong>Shock</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>125 g, 2 ms, half-sine</td>
<td></td>
</tr>
<tr>
<td>Nonoperating</td>
<td>200 g, 2 ms, half-sine</td>
<td></td>
</tr>
<tr>
<td><strong>Random vibration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate</td>
<td></td>
</tr>
</tbody>
</table>
Nonoperating

<table>
<thead>
<tr>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range of temperatures.

---

### 43.9 cm (17.3 in) HD+ display specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>23.3 cm</td>
</tr>
<tr>
<td>Depth</td>
<td>39.9 cm</td>
</tr>
<tr>
<td>Diagonal</td>
<td>43.9 cm</td>
</tr>
<tr>
<td>Weight</td>
<td>570 g max (1.26 lbs)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>300:1 (min)</td>
</tr>
<tr>
<td>Brightness</td>
<td>200 nits (typical)</td>
</tr>
<tr>
<td>Backlight</td>
<td>LED</td>
</tr>
<tr>
<td>Active area</td>
<td>382.08×214.92</td>
</tr>
<tr>
<td>Total power consumption</td>
<td>5.3 W max</td>
</tr>
<tr>
<td>Viewing angle</td>
<td>SVA</td>
</tr>
</tbody>
</table>

### 43.9 cm (17.3 in) FHD display specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>23.3 cm</td>
</tr>
<tr>
<td>Depth</td>
<td>39.9 cm</td>
</tr>
<tr>
<td>Diagonal</td>
<td>43.9 cm</td>
</tr>
<tr>
<td>Weight</td>
<td>590 g max (1.30 lbs)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>500:1 (min)</td>
</tr>
<tr>
<td>Brightness</td>
<td>300 nits (typical)</td>
</tr>
<tr>
<td>Backlight</td>
<td>LED</td>
</tr>
<tr>
<td>Active area</td>
<td>382.08×214.92</td>
</tr>
</tbody>
</table>
### Hard drive specifications

<table>
<thead>
<tr>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total power consumption</strong></td>
<td>7.0 W max</td>
</tr>
<tr>
<td><strong>Viewing angle</strong></td>
<td>WVA</td>
</tr>
</tbody>
</table>

#### Hard drive specifications

<table>
<thead>
<tr>
<th></th>
<th>1 TB*</th>
<th>500 GB*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>9.5 mm</td>
<td>9.5 mm or 7 mm</td>
</tr>
<tr>
<td>Width</td>
<td>7.0 mm</td>
<td>7.0 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>101 g</td>
<td>101 g</td>
</tr>
<tr>
<td><strong>Interface type</strong></td>
<td>SATA</td>
<td>SATA</td>
</tr>
<tr>
<td><strong>Transfer rate</strong></td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>ATA security</td>
<td>ATA security</td>
</tr>
<tr>
<td><strong>Seek times</strong> (typical read, including setting)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single track</td>
<td>3 ms</td>
<td>3 ms</td>
</tr>
<tr>
<td>Average</td>
<td>13 ms</td>
<td>13 ms</td>
</tr>
<tr>
<td>Maximum</td>
<td>24 ms</td>
<td>24 ms</td>
</tr>
<tr>
<td><strong>Logical blocks</strong></td>
<td>1,250,242,867</td>
<td>976,752,240</td>
</tr>
<tr>
<td><strong>Disk rotational speed</strong></td>
<td>5400 rpm</td>
<td>5400 rpm or 7200 rpm</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>5°C to 55°C (41°F to 131°F)</td>
<td></td>
</tr>
</tbody>
</table>

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may differ slightly.

**NOTE:** Certain restrictions and exclusions apply. Contact technical support for details.
## Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Access time</th>
<th>BD</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
<td>&lt; 250 ms</td>
<td>&lt; 185 ms</td>
</tr>
</tbody>
</table>

| Cache buffer | 1 MB |

### Data transfer rate

<table>
<thead>
<tr>
<th></th>
<th>BD-RAM</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>4X BD-RAM</td>
<td>18,000 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>16X CD-R</td>
<td>2,400 KB/sec</td>
<td></td>
</tr>
<tr>
<td>10X CD-RW</td>
<td>1,500 KB/sec</td>
<td></td>
</tr>
</tbody>
</table>
## Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Access time</th>
<th>CD</th>
<th>DVD</th>
<th>BD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
<td>165 ms</td>
<td>185 ms</td>
<td>250 ms</td>
</tr>
</tbody>
</table>

### Cache buffer

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache buffer</td>
<td>1 MB</td>
</tr>
</tbody>
</table>

### Data transfer rate

<table>
<thead>
<tr>
<th>Data transfer rate</th>
<th>CD-ROM</th>
<th>DVD</th>
<th>BD</th>
</tr>
</thead>
<tbody>
<tr>
<td>24X CD-ROM</td>
<td>3,600 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8X DVD</td>
<td>10,800 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16X CD-R</td>
<td>2,400 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10X CD-RW</td>
<td>1,500 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8X DVD+R</td>
<td>10,800 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8X DVD+RW</td>
<td>10,800 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8X DVD-R</td>
<td>10,800 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6X DVD-RW</td>
<td>8,100 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4X DVD+R(9)</td>
<td>5,400 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5X DVD-RAM</td>
<td>6,750 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4X BD-ROM</td>
<td>18,000 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4X BD-R read</td>
<td>18,000 KB/sec</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4X BD-RE read</td>
<td>18,000 KB/sec</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Transfer mode

<table>
<thead>
<tr>
<th>Transfer mode</th>
<th>Multiword DMA Mode</th>
</tr>
</thead>
</table>
## DVD±RW SuperMulti Double-Layer Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Access time</strong></th>
<th><strong>CD</strong></th>
<th><strong>DVD</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
<td>&lt; 140 ms</td>
<td>&lt; 160 ms</td>
</tr>
</tbody>
</table>

| **Cache buffer**         | 0.5 MB                                                               |

<table>
<thead>
<tr>
<th><strong>Data transfer rate</strong></th>
<th><strong>CD</strong></th>
<th><strong>DVD</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>24X CD-ROM</td>
<td>3,600 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>24X CD-R</td>
<td>3,600 KB/sec</td>
<td></td>
</tr>
<tr>
<td>16X CD-RW</td>
<td>2,400 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD+R</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD+RW</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD-R</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>6X DVD-RW</td>
<td>8,100 KB/sec</td>
<td></td>
</tr>
<tr>
<td>6X DVD+R(9)</td>
<td>5,400 KB/sec</td>
<td></td>
</tr>
<tr>
<td>5X DVD-RAM</td>
<td>6,750 KB/sec</td>
<td></td>
</tr>
</tbody>
</table>

| **Transfer mode**        | Multiword DMA Mode                                                   |                                                                                         |
### DVD-ROM Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Access time</th>
<th>CD</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
<td>&lt; 140 ms</td>
<td>&lt; 160 ms</td>
</tr>
</tbody>
</table>

| Cache buffer | 0.5 MB |

<table>
<thead>
<tr>
<th>Data transfer rate</th>
<th>CD</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>24X CD-ROM</td>
<td>3,600 KB/sec</td>
<td></td>
</tr>
<tr>
<td>8X DVD</td>
<td>10,800 KB/sec</td>
<td></td>
</tr>
<tr>
<td>24X CD-R</td>
<td>3,600 KB/sec</td>
<td></td>
</tr>
<tr>
<td>16X CD-RW</td>
<td>2,400 KB/sec</td>
<td></td>
</tr>
</tbody>
</table>
To protect your information, use Windows backup and restore utilities to back up individual files and folders, back up your entire hard drive, create system repair media (select models only) by using the installed optical drive (select models only) or an optional external optical drive, or create system restore points. In case of system failure, you can use the backup files to restore the contents of your computer.

In Windows 8, from the Start screen, type restore, click Settings, and then select from the list of displayed options.

- or -

In Windows 8.1, from the Start screen, type restore, and then select from the list of displayed options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to HP Support Assistant. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

## Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair media and your initial backup immediately after initial system setup. As you add new software and data files, you should continue to back up your system on a regular basis to maintain a reasonably current backup. The system repair media (select models only) are used to start up (boot) the computer and repair the operating system in case of system instability or failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

On Start screen, type backup, click Settings, and then select Save backup copies of your files with File History.

You can back up your information to an optional external hard drive or a network drive.
Note the following when backing up:

- Store personal files in the Documents library, and back it up regularly.
- Back up templates that are stored in their associated programs.
- Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore in Windows 8.0:

**NOTE:** Be sure that the computer is connected to AC power before you start the backup process.

**NOTE:** The backup process may take over an hour, depending on file size and the speed of the computer.

1. From the Start screen, type backup, and then click Settings.
2. Click **Save backup copy of your files with file history**.
   File History windows are launched.
3. Follow the on-screen instructions to use file history to backup files.
   - or -
   Click **recovery** to create a recovery drive using a USB flash drive.
   - or -
   Click **Windows 7 file recovery**, and then click **create a system image** to create a system image.

To create a backup using Backup and Restore in Windows 8.1:

**NOTE:** Be sure that the computer is connected to AC power before you start the backup process.

**NOTE:** The backup process may take over an hour, depending on file size and the speed of the computer.

1. From the Start screen, type backup.
2. Click **Save backup copy of your files with file history**.
   File History windows are launched.
3. Follow the on-screen instructions to use file history to backup files.
   - or -
   Click **recovery** to create a recovery drive using a USB flash drive.
   - or -
   Click **System Image Backup** to create a system image.
Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

- Windows recovery tools: You can use Windows Backup and Restore to recover information you have previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent Windows from starting correctly.

- f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image includes the Windows operating system and software programs installed at the factory.

**NOTE:** If you are unable to boot (start up) your computer and you cannot use the system repair media you previously created (select models only), you must purchase Windows 8 operating system media to reboot the computer and repair the operating system.

Using f11 recovery tools

**CAUTION:** Using f11 completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.
2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type C, and then select Computer.

**NOTE:** If the Recovery Image partition is not listed, you must recover your operating system and programs using the Windows 8 operating system media and the Driver Recovery media (both purchased separately).

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.
5. Choose your language.
6. Choose your keyboard layout.
7. Select Troubleshoot from the boot options menu.
8. Select Reset your PC, and follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to [http://www.hp.com/support](http://www.hp.com/support), select your country or region, and follow the on-screen instructions. You can also order the DVD by calling support. For contact information, see the Worldwide Telephone Numbers booklet included with the computer.
**CAUTION:** Using a Windows 8 operating system media completely erases hard drive contents and reformat the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. When reformatting is complete, the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

**NOTE:** This process takes several minutes.

1. If possible, back up all personal files.
2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive before the Windows operating system loads.
3. Power off the computer.
4. Power on the computer, and then press F9 to show the BIOS boot menu.
5. When the DVD is booting, select the DVD from the **UEFI Boot Sources**.
7. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows 8 operating system media and then insert the **Driver Recovery** media.
2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows Refresh option allows you to start fresh and keep what is important to you.

**IMPORTANT:** Refresh removes any traditional applications that were not originally installed on the system at the factory.

**NOTE:** During Refresh, a list of removed traditional applications will be saved so that you have a quick way to see what you might need to reinstall. See HP Support Assistant for instructions on reinstalling traditional applications. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

**NOTE:** You may be prompted for your permission or password when using Refresh. See HP Support Assistant for more information. To access HP Support Assistant on the Start screen, select the HP Support Assistant app.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.
2. Click **Settings**.
3. Click **Change PC settings** in the bottom-right corner of the screen.
4. In Windows 8.0, select **General** from the PC settings screen.
   
   - or -

   In Windows 8.1, select **Update and Recovery**, and then select **Recovery**.
5. Scroll the right-side choices down to display **Refresh your PC without affecting your files**.
6. Under **Refresh your PC without affecting your files**, select **Get started**, and follow the on-screen instructions.

Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal information before you give away or recycle your computer. The process described in this section provides a speedy, simple way to return the computer to its original state. This option removes all personal data, apps, and settings from your computer, and reinstalls Windows.

**IMPORTANT:** This option does not provide backups of your information. Before using this option, back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.
To use the f11 key:

1. Press f11 while the computer boots.
   
   – or –

   Press and hold f11 as you press the power button.

2. Choose your language.

3. Choose your keyboard layout.

4. Select Troubleshoot from the boot options menu.

5. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen.

4. In Windows 8.0, select General from the PC settings screen.

   – or –

   In Windows 8.1, select Update and Recovery, and then select Recovery.

5. Scroll the right-side choices down to display Remove everything and reinstall Windows.

6. Under Remove everything and reinstall Windows, select Get started, and follow the on-screen instructions.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you ever need to. These tools will help you return your computer to a proper working state, all with simple steps. This section provides information about the following processes:

- Creating recovery media and backups
- Restoring and recovering your system

### Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7 operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery DVD installs specific drivers and applications. See [Creating recovery media with HP Recovery Disc Creator](#) on page 145.

2. Use Windows Backup and Recovery tools to perform the following:
   - Back up individual files and folders
   - Back up your entire hard drive (select models only)
   - Create system repair discs (select models only) with the installed optical drive (select models only) or an optional external optical drive
   - Create system restore points

**NOTE:**

This guide describes an overview of backing up, restoring, and recovering options. For more details about the tools provided, see Help and Support. To access Help and Support, select **Start > Help and Support**.

**NOTE:**

HP recommends that you print the recovery procedures and save them for later use, in case of system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See [Backing up your information](#) on page 145.
Guidelines

- When creating recovery media or backing up to discs, use any of the following types of discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of optical drive you are using.
- Be sure that the computer is connected to AC power before you start the recovery media creation process or the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as well as select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery DVDs:

- Windows 7 operating system DVD—Installs the operating system without additional drivers or applications.
- Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP Software Setup utility installs drivers and applications.

Creating recovery media

**NOTE:** The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select **Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.**
2. Select **Windows disk.**
3. From the drop-down menu, select the drive for burning the recovery media.
4. Click the **Create** button to start the burning process. Label the disc after you create it, and store it in a secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select **Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.**
2. Select **Driver disk.**
3. From the drop-down menu, select the drive for burning the recovery media.
4. Click the **Create** button to start the burning process. Label the disc after you create it, and store it in a secure place.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you add new software and data files, you should continue to back up your system on a regular
basis to maintain a reasonably current backup. You should also create Windows system repair media (select models only) which can be used to start up (boot) the computer and repair the operating system in case of system instability or failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

- Store personal files in the Documents library, and back it up regularly.
- Back up templates that are stored in their associated directories.
- Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. The screen shot can be a time-saver if you have to reset your preferences.
- When backing up to discs, number each disc after removing it from the drive.

**NOTE:** For detailed instructions on various backup and restore options, perform a search for these topics in Help and Support. To access Help and Support, select Start > Help and Support.

**NOTE:** Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and Support.

To create a backup using Windows Backup and Restore:

**NOTE:** The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.
2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or create system repair media (select models only).

### Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

- Windows recovery tools: You can use Windows Backup and Restore to recover information you have previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows from starting correctly.
- f11 recovery tools (select models only): You can use the f11 recovery tools to recover your original hard drive image. The image includes the Windows operating system and software programs installed at the factory.

**NOTE:** If you are unable to boot (start up) your computer and you cannot use the system repair media you previously created (select models only), you must purchase Windows 7 operating system media to reboot the computer and repair the operating system.
Using the Windows recovery tools

Using the Windows recovery tools, you can:

- Recover individual files
- Restore the computer to a previous system restore point
- Recover information using recovery tools

**NOTE:** For detailed instructions on various recovery and restore options, perform a search for these topics in Help and Support. To access Help and Support, select **Start > Help and Support.**

**NOTE:** Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select **Start > Help and Support.**

To recover information you previously backed up:

1. Select **Start > All Programs > Maintenance > Backup and Restore.**
2. Follow the on-screen instructions to recover your system settings, your computer (select models only), or your files.

To recover your information using Startup Repair, follow these steps:

**CAUTION:** Some Startup Repair options will completely erase and reformat the hard drive. All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Recovery Image partition and the Windows partition.

To check for the Windows partition, select **Start > Computer.**

**NOTE:** If the Windows partition and the Recovery Image partition is not listed, you must recover your operating system and programs using the Windows 7 operating system DVD and the Driver Recovery media.

3. If the Windows partition is listed, restart the computer, and then press **f8** before the Windows operating system loads.
4. Select **Startup Repair.**
5. Follow the on-screen instructions.

**NOTE:** For additional information on recovering information using the Windows tools, select **Start > Help and Support.**
Using f11 recovery tools (select models only)

⚠️ CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.
2. If possible, check for the presence of the Recovery Image partition: click Start, right-click Computer, click Manage, and then click Disk Management.
   
   ❗️ NOTE: If the Recovery Image partition is not listed, you must recover your operating system and programs using the Windows 7 operating system media and the Driver Recovery media.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.
5. Follow the on-screen instructions.

Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to http://www.hp.com/support. For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the Worldwide Telephone Numbers booklet included with the computer.

⚠️ CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. When reformatting is complete, the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

 בארץ NOTE: This process takes several minutes.

1. If possible, back up all personal files.
2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before the Windows operating system loads.
3. When prompted, press any keyboard key.
4. Follow the on-screen instructions.
5. Click **Next**.

6. Select **Install now**.

7. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows 7 operating system DVD and then insert the *Driver Recovery* DVD.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
Recovery after a system failure is as good as your most recent backup. As you add new software and data files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if ever needed.

**Creating backups**

1. Create restore media immediately after you set up the computer.
2. As you add files, routinely create a backup of your system and personal information.

**Creating restore media**

You can create an HP Factory Image, using an installed or an external DVD±RW optical drive or a USB drive. The HP Factory Image can be used to perform system recovery in the event of a system failure. The recovery tool reinstalls the original operating system and HP programs and drivers that were installed at the factory.

To create the restore media:

1. Select **Computer > More Applications**.
2. In the left pane, click **Tools**, and then click **Create HP Factory Image** in the right pane.
3. Follow the on-screen instructions to create an image file to burn a recovery disc.

**NOTE:** The image produced by HP Create Factory Image can be written to a USB disk on key or a DVD. If you are writing to a DVD, follow the on-screen instructions. To write the image to a USB disk on key:

To write the image to a USB disk on key:

a. Insert the USB disk on key in a USB port.

b. To transfer the image to a USB disk on key, use the `dd` command.
Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can manually back up your information to an optional external drive, a network drive, or discs. Back up your system at the following times:

- At regularly scheduled times
- Before the computer is repaired or restored
- Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select **Computer > More Applications > Tools > Backup Manager Settings**, and click **Backup my home directory**.
2. Click **Storage Destination Location**, and then select a location to back up your information.
3. Click **Schedule**, and then select a time schedule to perform backups at a regularly scheduled time.

   To immediately back up your information, click the **Backup Now** check box.

   **NOTE:** Before you back up your information, be sure you have designated a location to save the backup files.

4. Click **Save and Backup** to start the backup and to save the backup settings.

To restore backup files:

1. Select **Computer > More Applications > Tools > Backup Manager Restore**.
2. Click **Backup Source**, and then select the location of the backup files.
3. Click **Restore Destination**, and then select the destination to restore the files.
4. To restore all files from the selected location, click **Restore all files**. To restore select files only, click **Restore selected files**, click **Select Files** and then select the files to be restored.
5. Under **Restore Point**, click the time and date of the backup.

   **NOTE:** If multiple backups have been performed, click **Use the latest version** to restore the latest version.

6. Click **Restore** to start restoring the files, or click **Cancel** to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state.
CAUTION: Using Recovery completely erases hard drive contents and reformats the hard drive. All files you have created and any software installed on the computer are permanently removed. The recovery tool reinstalls the original operating system and HP programs and drivers that were installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery media. If you have not already created it, see Creating restore media on page 150.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image into the optical drive or insert the USB disk on key into the USB port, and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu and select the option for the optical drive, if you are using a DVD to restore. If you are using a USB disk to key, select USB disk on key.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System- Restore?

6. Follow the on-screen instructions.

NOTE: The image produced by the Create Factory Image utility may be written to either a USB disk on a key or a DVD. To write the image to a disk, use the dd command to transfer the image to a USB disk on a key. The USB disk on a key may be inserted in a USB port.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal information before you give away or recycle your computer. The process described in this section provides a speedy, simple way to return the computer to its original state. This option removes all personal data, applications, and settings from your computer, and reinstalls the Linux operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option, back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.
The following options are available:

- **Cancel/Reboot**—Reboots the system. No recovery or restore activity is performed.
- **Recover/Repair System**—This option repairs a system that is not working properly and preserves user data.
- **Restore Factory System**—This option restores the system back to the original factory state. User data is not preserved.

Select an option and follow the on-screen instructions.
The purpose of this document is to provide general information regarding non-volatile memory in industry-standards based HP Business Notebook PC systems and provide general instructions for restoring nonvolatile memory that can contain personal data after the system has been powered off and the hard drive has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR memory. The amount of nonvolatile memory present in the system depends upon the system configuration. Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped from HP assuming that no subsequent modifications have been made to the system and assuming that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed in the Maintenance & Service Guides available for HP PC products available on the product support pages at www.hp.com.

1. Follow steps (a) through (l) below to restore the nonvolatile memory that can contain personal data. Restoring or re-programming nonvolatile memory that does not store personal data is neither necessary nor recommended.

a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the bottom of the display, or press the ESC key to display the start up menu, then press F10. If the system has a BIOS administrator password, enter the password at the prompt.

b. Select the File menu, then Restore Defaults.

c. Select the System Configuration menu, then Restore Security Defaults.

d. If an asset or ownership tag is set, select the Security menu and scroll down to the Utilities menu. Select System IDs, and then select the tag that has been set. Press the spacebar once to clear the tag, then press Enter to return to the prior menu.

e. If a DriveLock password is set, select the Security menu, scroll down to DriveLock, then select DriveLock password. Select the desired hard drive. Click Disable protection, enter the existing master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
f. If an Automatic DriveLock password is set, select the **Security** menu, scroll down to **Automatic DriveLock**, then select the desired hard drive and disable protection. Repeat this procedure if more than one hard drive has an Automatic DriveLock password.

g. Select the **File** menu, then **Reset BIOS Security** to factory default. Click **yes** at the warning message.

h. Select the **File** menu, then **Save Changes and Exit**.

i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor, one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor; press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VPro™, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select **System Configuration**, then **AMT Options**. Then select **Un-configure AMT on next boot**. Select **Save** then **Yes**. Select the **File** menu, and then select **Save Changes and Exit**. Reboot the system and confirm that you want to un-configure AMT.

j. If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate it.

k. If the optional Absolute® Software Computrace® management and tracking service was activated on the notebook PC, contact the provider to deactivate it.

l. Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

a. **Hard Disk Drive (HDD)**

Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when prompted near the bottom of the display, or press ESC to display the start up menu, then press F10. Select the **Security** menu and scroll down to the **Utilities** menu. Select **Disk Sanitizer** and select the desired drive. For a higher level of protection, select **Optimum**.

**NOTE:** This process will take a long time, and the amount of time varies based on the hard drive capacity.

b. **Solid State Drive (SSD)**

Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by powering on the system and pressing F10 when prompted near the bottom of the display. Select the **Security** menu and scroll down to the **Utilities** menu. Select **Secure Erase** and select the desired hard drive.
## Non-volatile memory usage

<table>
<thead>
<tr>
<th>Non Volatile Memory Type</th>
<th>Amount (Size)</th>
<th>Does this memory store customer data?</th>
<th>Does this memory retain data when power is removed?</th>
<th>What is the purpose of this memory?</th>
<th>How is data input into this memory?</th>
<th>How is this memory write protected?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time Clock (RTC) battery backed-up CMOS configuration memory (CMOS)</td>
<td>256 Bytes</td>
<td>No</td>
<td>Yes</td>
<td>Stores system date and time and limited keyboard controller data.</td>
<td>Using the F10 Setup utility or changing the Microsoft® Windows® date &amp; time.</td>
<td>This memory is not write-protected. HP recommends password protecting the F10 Setup utility.</td>
</tr>
<tr>
<td>Controller (NIC) EEPROM</td>
<td>64 Kbytes (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Store NIC configuration and NIC firmware.</td>
<td>Using a utility from the NIC vendor that can be run from DOS.</td>
<td>A utility is required to write data to this memory and is available from NIC vendor. Writing data to this ROM in an inappropriate manner will render the NIC non-functional.</td>
</tr>
<tr>
<td>Keyboard ROM</td>
<td>64 Kbytes (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Stores firmware code (keyboard, mouse, &amp; battery management).</td>
<td>Programmed at the factory. Code is updated when the system BIOS is updated.</td>
<td>A utility is required for writing data to this memory and is available on the HP website. Writing data to this ROM in an inappropriate manner can render the PC non-functional.</td>
</tr>
<tr>
<td>DIMM Serial Presence Detect (SPD) configuration data</td>
<td>256 Bytes per memory module, 128 Bytes programmable (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Stores memory module information.</td>
<td>Programmed by the memory vendor.</td>
<td>Data cannot be written to this memory when the module is installed in a PC. The specific write protection method varies by memory vendor.</td>
</tr>
<tr>
<td>System BIOS</td>
<td>4 to 5 MBytes</td>
<td>Yes</td>
<td>Yes</td>
<td>Store system BIOS code and PC configuration data.</td>
<td>System BIOS code is programmed at the factory. Code is updated when the system BIOS is updated. Configuration data and settings are input using the F10 setup utility or a custom utility.</td>
<td>A utility is required for writing data to this memory and is available on the HP website. Writing data to this ROM in an inappropriate manner can render the PC non-functional.</td>
</tr>
<tr>
<td>Non Volatile Memory Type</td>
<td>Amount (Size)</td>
<td>Does this memory store customer data?</td>
<td>Does this memory retain data when power is removed?</td>
<td>What is the purpose of this memory?</td>
<td>How is data input into this memory?</td>
<td>How is this memory write protected?</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Intel Management Engine Firmware (present only in models ending in a ‘p’ or ‘w’ or with Intel Centrino Pro technology)</td>
<td>1.5 or 5MByte</td>
<td>Yes</td>
<td>Yes</td>
<td>Stores Management Engine Code, Settings, Provisioning Data and iAMT third party data store.</td>
<td>Management Engine Code is programmed at the factory. Code is updated via Intel secure firmware update utility. Unique Provisioning Data can be entered at the factory or by an administrator using the Management Engine (MEBx) setup utility. The third party data store contents can populated by a remote management console or local applications registered by an administrator to have access to the space.</td>
<td>The Intel chipset is configured to enforce HW protection to block all direct read/write access to this area. An Intel utility is required for updating the firmware. Only firmware updates digitally signed by Intel can be applied using this utility.</td>
</tr>
<tr>
<td>Bluetooth flash</td>
<td>2Mbit</td>
<td>No</td>
<td>Yes</td>
<td>Stores Bluetooth configuration and firmware.</td>
<td>Programmed at the factory. Tools for writing data to this memory are not publicly available but can be obtained from the silicon vendor.</td>
<td>A utility is required for writing data to this memory and is made available through newer versions of the driver if the flash requires an upgrade.</td>
</tr>
<tr>
<td>802.11 WLAN EEPROM</td>
<td>4kb to 8kb</td>
<td>No</td>
<td>Yes</td>
<td>Stores configuration and calibration data.</td>
<td>Programmed at the factory. Tools for writing data to this memory are not made public.</td>
<td>A utility is required for writing data to this memory and is typically not made available to the public unless a firmware upgrade is necessary to address a unique issue.</td>
</tr>
<tr>
<td>Web Camera</td>
<td>64K bit</td>
<td>No</td>
<td>Yes</td>
<td>Store Web Cam configuration and firmware.</td>
<td>Using a utility from the device manufacturer that can be run from Windows.</td>
<td>A utility is required for writing data to this memory and is typically not made available to the public unless a firmware upgrade is necessary to address a unique issue.</td>
</tr>
<tr>
<td>Fingerprint Reader</td>
<td>512kByte Flash</td>
<td>Yes</td>
<td>Yes</td>
<td>Stores fingerprint templates.</td>
<td>By enrolling in HP ProtectTools Security Manager.</td>
<td>Only a digitally signed application can make the call to write to the flash.</td>
</tr>
</tbody>
</table>
Questions and answers

1. **How can the BIOS settings be restored (returned to default settings)?**
   - Turn on or restart the computer and press **F10** when prompted near the bottom of the display.
   - Select **File**, then select **Restore defaults**.
   - Follow the on-screen instructions.
   - Select **File**, save changes and exit, then press **Enter**.

2. **What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory module? How would this data be written?**

   The DIMM SPD memory contains information about the memory module such as size, serial number, data width, speed/timing, voltage and thermal information. This information is written by the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is not installed in a PC. There are various third party tools available to read SPD memory.

3. **Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so how?**

   The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the write function.

4. **In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can be written by the customer. Is this true for these BIOS chips?**

   Yes, they are flash memory chips.

5. **What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?**

   This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. **Does resetting the CMOS configuration memory return the PC back to factory defaults?**

   The process of resetting the CMOS will return certain system settings to factory default but will not reset many of the system data and configuration defaults to their default settings. To return these system data and configuration defaults to default settings, refer to question and answer 1 and follow the instructions for returning the BIOS settings to factory defaults.
The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where the computer is used.

**Requirements for all countries**

The following requirements are applicable to all countries and regions:

- The length of the power cord set must be at least **1.0m** (3.3 ft) and no more than **2.0 m** (6.5 ft).
- All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the country or region where the power cord set will be used.
- The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 250 V AC, as required by the power system of each country or region.
- The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
### Requirements for specific countries and regions

<table>
<thead>
<tr>
<th>Country/region</th>
<th>Accredited agency</th>
<th>Applicable note number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>EANSW</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>OVE</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>CEBC</td>
<td>1</td>
</tr>
<tr>
<td>Canada</td>
<td>CSA</td>
<td>2</td>
</tr>
<tr>
<td>Denmark</td>
<td>DEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Finland</td>
<td>FIMKO</td>
<td>1</td>
</tr>
<tr>
<td>France</td>
<td>UTE</td>
<td>1</td>
</tr>
<tr>
<td>Germany</td>
<td>VDE</td>
<td>1</td>
</tr>
<tr>
<td>Italy</td>
<td>IMQ</td>
<td>1</td>
</tr>
<tr>
<td>Japan</td>
<td>METI</td>
<td>3</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>KEMA</td>
<td>1</td>
</tr>
<tr>
<td>Norway</td>
<td>NEMKO</td>
<td>1</td>
</tr>
<tr>
<td>The People’s Republic of China</td>
<td>COC</td>
<td>5</td>
</tr>
<tr>
<td>South Korea</td>
<td>EK</td>
<td>4</td>
</tr>
<tr>
<td>Sweden</td>
<td>SEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Switzerland</td>
<td>SEV</td>
<td>1</td>
</tr>
<tr>
<td>Taiwan</td>
<td>BSMI</td>
<td>4</td>
</tr>
<tr>
<td>The United Kingdom</td>
<td>BSI</td>
<td>1</td>
</tr>
<tr>
<td>The United States</td>
<td>UL</td>
<td>2</td>
</tr>
</tbody>
</table>

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.
A
AC adapter 17
AC adapter, spare part numbers 35, 37
AC adapter/battery light 14
accessory battery connector, identifying 19
audio, product description 4
audio-in (microphone) jack, identifying 15
audio-out (headphone) jack, identifying 15
audio/USB board
removal 93
spare part number 26, 40, 93
Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive
specifications 135
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
precautions 42
spare part number 26, 34, 39, 57, 59
specifications 134
Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
spare part number 26, 34, 39, 57, 59
Bracket Kit, spare part number 32, 40
buttons
left pointing stick 8
left TouchPad 8
optical drive eject 15
power 11
right pointing stick 8
right TouchPad 8
Windows button 12
computer reset 142, 152
Computer Setup
navigating and selecting 111, 119, 127
restoring default settings 111, 119, 128
computer specifications 131
connector, power 17
connector, service considerations 41
D
diskette drive
precautions 42
display assembly
removal 84
spare part numbers 25, 84
display bezel
removal 67
spare part numbers 28, 37, 39, 67
display enclosure, spare part number 29, 40, 90
Display Hinge Kit, spare part number 28, 37
display panel
product description 1
removal 70
spare part numbers 39, 70
display panel cable
spare part number 28
display specifications 132
display/webcam cable, illustrated 31
DisplayPort, identifying 16
docking connector, identifying 19
docking support, product description 5
B
backup 150
Backup and Restore 139, 146
backup tools 144
backups
creating 145
recovering 147
base enclosure
spare part number 27, 38
battery
removal 46
spare part numbers 27, 37, 46
battery release latch 19
battery, identifying 19
BIOS
determining version 112, 120, 128
downloading an update 113, 121, 129
updating 112, 120, 128
Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
spare part number 26, 34, 39, 57, 59
Bracket Kit, spare part number 32, 40
buttons
left pointing stick 8
left TouchPad 8
optical drive eject 15
power 11
right pointing stick 8
right TouchPad 8
Windows button 12
computer reset 142, 152
Computer Setup
navigating and selecting 111, 119, 127
restoring default settings 111, 119, 128
computer specifications 131
connector, power 17
connector, service considerations 41
D
diskette drive
precautions 42
display assembly
removal 84
spare part numbers 25, 84
display bezel
removal 67
spare part numbers 28, 37, 39, 67
display enclosure, spare part number 29, 40, 90
Display Hinge Kit, spare part number 28, 37
display panel
product description 1
removal 70
spare part numbers 39, 70
display panel cable
spare part number 28
display specifications 132
display/webcam cable, illustrated 31
DisplayPort, identifying 16
docking connector, identifying 19
docking support, product description 5
B
backup 150
Backup and Restore 139, 146
backup tools 144
backups
creating 145
recovering 147
base enclosure
spare part number 27, 38
battery
removal 46
spare part numbers 27, 37, 46
battery release latch 19
battery, identifying 19
BIOS
determining version 112, 120, 128
downloading an update 113, 121, 129
updating 112, 120, 128
Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive
specifications 135
Blu-ray R/RE DVD±RW SuperMulti Double-Layer Drive
precautions 42
spare part number 26, 34, 39, 57, 59
specifications 134
Blu-ray ROM DVD±RW SuperMulti Double-Layer Drive
spare part number 26, 34, 39, 57, 59
Bracket Kit, spare part number 32, 40
buttons
left pointing stick 8
left TouchPad 8
optical drive eject 15
power 11
right pointing stick 8
right TouchPad 8
Windows button 12
computer reset 142, 152
Computer Setup
navigating and selecting 111, 119, 127
restoring default settings 111, 119, 128
computer specifications 131
connector, power 17
connector, service considerations 41
D
diskette drive
precautions 42
display assembly
removal 84
spare part numbers 25, 84
display bezel
removal 67
spare part numbers 28, 37, 39, 67
display enclosure, spare part number 29, 40, 90
Display Hinge Kit, spare part number 28, 37
display panel
product description 1
removal 70
spare part numbers 39, 70
display panel cable
spare part number 28
display specifications 132
display/webcam cable, illustrated 31
DisplayPort, identifying 16
docking connector, identifying 19
docking support, product description 5
C
Cable Kit, spare part number 31, 40
cables, service considerations 41
caps lock light, identifying 9
chipset, product description 1
components
bottom 19
display 18
front 14
left side 16
rear 17
right side 15
top 8
computer part number 22
mouse
  spare part number 35, 37
multifunction board
  removal 77
  spare part number 25, 37, 77
mylar screw covers, spare part number 29
N
network jack, identifying 17
num lock light 9
O
operating system, product description 6
optical drive
  precautions 42
  product description 3
  removal 57
  spare part numbers 26, 34, 39, 57
specifications 134, 135, 136, 137
optical drive eject button, identifying 15
optical drive, identifying 15
P
packing guidelines 43
plastic parts 41
Plastics Kit, spare part number 30, 37
pointing device
  product description 5
pointing stick 8
ports
  DisplayPort 16
  product description 5
  USB 16
power button board
  removal 82
  spare part number 25, 37, 82
power button, identifying 11
power cable, illustrated 31
power connector cable
  removal 105
power connector, identifying 17
power cord
  set requirements 159
  spare part numbers 35, 36
power lights 9, 14
power requirements, product description 5
processor
  product description 1
  removal 98
  spare part numbers 37, 39
  spare part numbers 25, 37, 40, 98
processor heat sink
  removal 95
  spare part numbers 26, 27, 39, 95
processor,
  spare part numbers 40
product description
  audio 4
  chipset 1
  display panel 1
  docking support 5
  Ethernet 4
  external media cards 4
  graphics 1
  hard drives 2
  keyboard 5
  memory module 1
  microphone 4
  operating system 6
  optical drives 3
  pointing devices 5
  ports 5
  power requirements 5
  processors 1
  product name 1
  security 6
  serviceability 7
  solid state drive 2
  video 4
  wireless 4
  product name 1, 21, 22
  product number 22
R
rear cover, left, illustrated 30
rear cover, right, illustrated 30
recovery 142, 150
recognition media, creating 145
recognition media, using for restore 148
recovery partition 140, 148
recovery tools 144
recovery tools, Windows 147
recovery, system 146
recycle
  computer 142
refresh 142
removal/replacement preliminaries 41
  procedures 46, 67
remove everything and reinstall Windows 142
reset
  computer 142, 152
  steps 142, 152
restoring the hard drive 140, 148
RJ-45 (network) jack, identifying 17
RJ-45 bracket, illustrated 32
RTC battery
  removal 55
  spare part number 27, 39, 55
S
Screw Kit
  spare part number 35, 40
SD card reader insert, illustrated 30
security cable slot, identifying 16
security lock bracket, illustrated 32
security, product description 6
sequential part numbers 36
serial number 21, 22
service considerations 41
service door
  removal 48
  spare part number 27, 37, 48
service door release latch 19
service tag 21
serviceability, product description 7
setup utility
  navigating and selecting 111, 119
  restoring default settings 111, 119
SIM slot, identifying 19
SIM, removal 47
SLED
  remove everything and reinstall option 152
slots
  ExpressCard 16
  security cable 16
  SIM 19
  smart card 16
Smart Card reader
  removal 92
  spare part number 26, 40, 92
smart card slot 16
solid-state drive
  precautions 42
  product description 2
  spare part numbers 26, 33, 51
solid-state drive (SSD)
  removal 51
speaker assembly
  removal 75
  spare part number 37, 75
specifications
  Blu-ray Disc ROM with
    SuperMulti DVD±R/RW DL Drive 135
  Blu-ray R/RE DVD±RW
    SuperMulti Double-Layer Drive 134
  computer 131
display 132
  DVD-ROM Drive 137
  DVD±RW SuperMulti Double-Layer Drive 136
  hard drive 133
  optical drive 134, 135, 136, 137
Startup Repair, using 147
static-shielding materials 45
system board
  removal 106
  spare part numbers 25, 106
System Diagnostics 116

T
  tools required 41
top cover
  removal 72
  spare part number 25, 39, 72
TouchPad
  buttons 8
  removal 79
  spare part number 79
TouchPad light, identifying 9
TouchPad zone
  identifying 8
transporting guidelines 43

U
  upgrade bay hard drive
    removal 59
    spare part number 59
USB 3.0 port 15, 16
USB legacy support 110, 118, 126
USB ports, identifying 15, 16

V
  vents, identifying 16, 17, 20
video, product description 4

W
  warranty period 22
webcam 18
  identifying 18
  removal 69
  spare part number 29, 39, 69
webcam light, identifying 18
Windows
  Refresh 142
  reinstall 142
  remove everything and reinstall option 142
  reset 142
Windows 7 operating system DVD
  creating 145
  using for restore 148
Windows 7 operating system media
  creating 145
  using for restore 148
Windows 8 operating system DVD 140
Windows button, identifying 12
Windows Startup Repair, using 147
wireless
  product description 4
wireless antennas, identifying 18
wireless light 9
WLAN antenna and cables, spare part number 29
WLAN antennas, identifying 18
WLAN module
  removal 52
  spare part numbers 26, 37, 52
workstation guidelines 44
WWAN antenna and cables, spare part number 29
WWAN antennas, identifying 18
WWAN module
  removal 54
  spare part numbers 26, 37, 54

Index 165